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Методичні вказівки містять завдання до проведення практичних робіт з дисципліни 

«Комп’ютерний дизайн поліграфії та реклами» для студентів спеціальності 122 Комп’ютерні 

науки, спеціалізація: Інформаційні технології проектування. 

Розроблені завдання служать для розвитку у студентів навичок роботи в системі 

CorelDraw – пакеті для роботи з векторною графікою, підготовки ілюстрацій для поліграфічної 

та рекламної продукції. 

Призначаються для студентів денної форми навчання. 
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ВСТУП 

 

Дисципліна «Комп’ютерний дизайн поліграфії та реклами» відноситься до циклу 

дисциплін професійної та практичної підготовки фахівців за спеціальністю 122  Комп’ютерні 

науки, спеціалізація: Інформаційні технології проектування. 

Мета дисципліни полягає в отриманні студентами знань про сутність, поняття, 

можливості комп’ютерного дизайну поліграфічної та рекламної продукції з застосування 

сучасних провідних програмних пакетів верстки, створення та обробки елементів векторної та 

растрової графіки. 

Мета практичних занять – вироблення у студентів вміння самостійно застосовувати для 

вирішення конкретних задач щодо дизайну поліграфічної та рекламної продукції, які отримані з 

лекційного курсу. Кожне практичне заняття з дисципліни «Комп’ютерний дизайн поліграфії та 

реклами» повинно навчити студентів самостійно працювати з науково-технічною літературою 

та програмною документацією в області комп'ютерного дизайну поліграфії та реклами; 

вирішувати окремі прикладні завдання з дизайну поліграфії та реклами; працювати в рамках 

сучасних технологій комп'ютерного дизайну; оформляти поліграфічну та рекламну продукцію. 

Данні методічні вказівки розроблені для навчання роботі із пакетом векторної графіки 

СorelDRAW, практичні вправи допоможуть зробити освоєння CorelDRAW не тільки корисним, 

але й захоплюючим. 

CorelDRAW являє собою інтегрований об'єктно-орієнтований пакет програм для роботи 

з ілюстративної графікою. Під словами «інтегрований пакет» слід розуміти, що CorelDRAW 

являє собою не окрему програму, орієнтовану на рішення якої-небудь однієї чітко поставленої 

задачі, а сукупність програм (пакету), орієнтованих на вирішення безлічі різних задачь, що 

виникають при роботі користувача в певній прикладній області, а саме – в області 

ілюстративної графіки. Інтегрірованість пакета слід розуміти в тому сенсі, що входять до нього 

програми можуть легко обмінюватися даними чи послідовно виконувати різні дії над одними і 

тими ж даними. Так досягається багатофункціональність пакету, можливості різних програм 

об'єднуються, інтегруються в єдине ціле, що представляє собою щось більше, ніж суму своїх 

складових частин. 

Ілюстративна графіка – це прикладна галузь машинної графіки, порівняно недавно 

виділилася в окремий напрям поряд з графікою ділової, наукової та інженерної. До області 

ілюстративної графіки відносяться в першу чергу рисунки, колажі, рекламні оголошення, 

заставки, постери – все, що прийнято називати художньою продукцією. Об'єкти ілюстративної 

графіки відрізняються від об'єктів інших прикладних областей своєї первинністю – вони не 

можуть бути побудовані автоматично за деякими вихідними даними, без участі художника або 

дизайнера. 

Термін «об'єктно-орієнтований» слід розуміти в тому сенсі, що всі операції, що 

виконуються в процесі створення і редагування зображень, користувач проводить не з 

зображенням в цілому і не з його найдрібнішими, атомарними частками (пікселями точкового 

зображення), а з об'єктами – семантично навантаженими елементами зображення. Починаючи із 

стандартних об'єктів (кіл, прямокутників, текстів і т.д.), користувач може будувати складені 

об'єкти і маніпулювати ними як єдиним цілим. Таким чином, зображення стає ієрархічною 

структурою, на самому верху якої знаходиться ілюстрація в цілому, а в самому низу – 

стандартні об'єкти. 

Об'єктна орієнтація CorelDRAW дає користувачеві майже необмежену гнучкість в 

роботі. Можна виділяти окремі об'єкти зображення і модифікувати їх на будь-якому етапі 

роботи, що неможливо ні для точкових зображень, ні при використанні традиційних 

інструментів художника – паперу, кисті, пера, фарб, олівців.  
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Робоче середовище та інтерфейс користувача 

Після запуску програми на екрані розкривається представлене на рис. 1 головне вікно 

CorelDRAW з основними елементами призначеного для користувача інтерфейса.Рабочая серед 

користувачів CorelDRAW 

 
Рис. 1. Робоче середовище користувача CorelDRAW 

Під рядком заголовка вікна (1) розташовується рядок меню (2). В CorelDRAW меню 

дуже складне, з великим числом підміню і команд. Як і в будь-який інший програмі, меню 

забезпечує доступ до більшості функцій CorelDRAW, але дуже багато дій можуть виконуватися 

і без нього. При бажанні будь-які команди і інструменти CorelDRAW можна перемістити в 

будь-яке меню. 

У лівій частині робочого простору розташований специфічний для продуктів фірми Corel 

елемент інтерфейсу - так званий набір інструментів (toolbox - 7). З вибору інструментів 

починаються практично всі дії користувача над об'єктами зображення. 

Деякі кнопки інструментів забезпечені трикутником в нижньому правому куті. Ця 

вказівка, що насправді з кнопкою пов'язаний не один, а кілька інструментів. Щоб побачити їх 

все, замість швидкого клацання кнопкою миші її слід натиснути (відпустивши тільки після 

паузи в одну-дві секунди) - на екрані розкриється панель конкретного інструменту. На рис. 2 

представлена панель, що розкривається кнопкою інструменту Fill (Заливка). 

 
Рис. 2. Інструмент панель Fill (Заливка) в розкритому стані 

Щоб вибрати інструмент, досить клацнути на його кнопці. Як правило, кожному з 

інструментів відповідає своя форма покажчика миші. У розташованій під рядком меню 

стандартної панелі інструментів (toolbar - 3) розташовані елементи управління, відповідні 

найбільш часто виконуваних командам: відкриття, збереження і закриття файлів ілюстрацій, 

операціям з системним буфером обміну, режимам і масштабу перегляду ілюстрацій. 

Нижче стандартної панелі інструментів за замовчуванням розташовується панель 

атрибутів або параметрів (property bar - 4). Вона являє собою сукупність елементів управління, 

відповідних керуючим параметрам виділеного об'єкта і стандартних операцій, які можна 
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виконати над ним за допомогою обраного інструменту. Вміст панелі параметрів постійно 

змінюється, вона є основним робочим інструментом користувача. 

Уздовж правої межі вікна розташована-екранна палітра кольорів (color palette - 11). Вона 

застосовується для завдання кольору заливки і обведення об'єктів ілюстрації. 

У нижнього краю вікна CorelDRAW знаходиться рядок стану (status bar - 9). У ній в 

процесі роботи виводяться відомості про виділений об'єкт і багато допоміжної інформації про 

режим роботи програми. 

Основна частина робочого простору CorelDRAW відведена для розміщення вікон 

документів (drawing windows) CorelDRAW. Після створення документа CorelDRAW в такому 

вікні видно тільки зображення друкованої сторінки, на якій буде розміщуватися ілюстрація (6). 

Межі сторінки показані у вигляді рамки з тінню, проте вони не є елементом зображення. 

Об'єкти, з яких буде далі будуватися ілюстрація, повинні розташовуватися в межах цих 

кордонів. Інший простір вікна ілюстрації має свою назву - робочий стіл (5) - і використовується 

зазвичай як тимчасове сховище об'єктів. Розмір робочого столу CorelDRAW значно більше, ніж 

його видима на екрані частина. Для перегляду невидимої частини вікна служать смуги 

прокрутки, розташовані по правому і нижньому краях вікна документа. Зліва від 

горизонтальної смуги прокручування розташовуються елементи управління, що дозволяють 

переходити між окремими сторінками багатосторінкових документів - кнопки і ярлички з 

назвами сторінок, разом утворюють так званий навігатор (8). 

На лівому і верхньому краях вікна документа розташовані координатні лінійки (rulers), 

службовці для вимірювання координат об'єктів і розміщення напрямних. 

Величезну роль в інтерфейсі CorelDRAW грають вікна (палітри) (dockers - 10), що 

пристикуються, в згорнутому вигляді представляють собою ярлички з назвами, розташовані 

зліва від екранної палітри кольорів. За своїми функціями вони нагадують діалогові вікна, але на 

відміну від більшості діалогових вікон можуть постійно бути присутнім в робочому просторі. 

Створення нового документа 

За замовчуванням після запуску програми CorelDRAW завжди відкривається вікно 

документа. Якщо програма не запускається клацанням на значку файлу, асоційованого з 

CorelDRAW, це буде новий документ. Якщо в процесі роботи буде потрібно створити ще один 

новий документ, виберіть команду New (Новий документ) в меню File (Файл) або просто 

клацніть на кнопці New (Новий документ), розташованої на лівому краю стандартної панелі 

інструментів. В результаті розкриється нове вікно документа CorelDRAW з чистою друкованої 

сторінкою. 

Підказка 

Якщо виникають труднощі з пошуком тієї чи іншої кнопки на панелях інструментів, 

переміщаючи на них курсор миші, затримуйтеся на кожній кнопці на секунду-другу. Поруч з 

кнопкою буде з'являтися підказка з її назвою. 

Відкриття та закриття документа 

Раніше створені документи CorelDRAW відкриваються цілком стандартними для 

прикладних програм Windows способами: при запуску програми після клацання на значку 

асоційованого з CorelDRAW файлу; командою File> Open (Файл> Відкрити) або кнопкою Open 

(Відкрити), розташованої на стандартній панелі інструментів. У двох останніх випадках на 

екрані розкриється діалогове вікно Open Drawing (Відкрити документ). 

У цьому діалоговому вікні присутні всі стандартні елементи вікна відкриття документа 

будь-якої прикладної програми Windows. Крім того, праворуч від списку файлів є область 

попереднього перегляду, в якій при встановленому прапорці Preview (Попередній перегляд) 

відображається зменшене зображення, яке зберігається в файлі. Якщо при збереженні 

документів CorelDRAW задаються ключові слова або зауваження, вони з'являються в полях 

Keywords (Ключові слова) і Notes (Зауваження). 

Увага 
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Зменшені копії зображення можуть не включатися в файл при його збереженні, і в таких 

випадках навіть при встановленому прапорці Preview (Попередній перегляд) в області 

попереднього перегляду нічого не відображається. 

Для закриття поточного документа виберіть команду File> Close (Файл> Закрити) або 

просто клацніть на кнопці закриття вікна документа, що знаходиться в правому верхньому куті 

цього вікна. Якщо документ після останнього запису на диск змінювався, програма запросить 

підтвердження на його збереження перед закриттям. 

Збереження документа 

Збереження документа CorelDRAW виконується вибором команди File> Save (Файл> 

Зберегти) або клацанням на кнопці Save (Зберегти) стандартної панелі інструментів. Якщо 

раніше цей документ не зберігався, на екрані відкриється діалогове вікно Save Drawing 

(Зберегти документ). 

Для збереження документа слід вибрати папку, в якій він повинен бути збережений, 

ввести ім'я файлу в поле File name (Ім'я файлу) і клацнути на кнопці Save (Зберегти). Перед 

останньою дією можна ввести у відповідні поля ключові слова і зауваження. Зверніть увагу на 

список, що розкривається 

Version (Версія). Якщо необхідно зберегти файл у форматі однієї з ранніх версій 

CorelDRAW, перед збереженням файлу слід вибрати зі списку відповідну альтернативу. 

Якщо файл раніше вже зберігався, при виборі команди збереження повторний запис на 

диск виконується без відкриття діалогового вікна Save Drawing (Зберегти документ). 

Якщо потрібно створити копію файлу, збережіть його в іншій папці командою File> Save 

As (Файл> Зберегти як). Файл при цьому можна залишити колишнім або задати нове. 

Зміна параметрів сторінки та одиниць вимірювання 

Після створення нового документа іноді потрібно змінити прийняті за замовчуванням 

розміри друкованої сторінки. Ця операція виконується за допомогою елементів панелі 

атрибутів, зовнішній вигляд якої для ситуації, коли на малюнку не виділено жодного об'єкту, 

представлений на рис. 3. 

 
Рис. 3. Панель атрибутів при відсутності виділених об'єктів 

Розмір друкованих сторінок документа вибирається в списку Paper Type / Size (Тип / 

формат паперу), розташованому в самій лівій позиції панелі атрибутів. Розмір друкованої 

сторінки не обов'язково повинен відповідати формату паперу, на якій потім буде роздрукована 

ілюстрація. Досить, щоб він не перевищував розмірів листа. Якщо розмір друкованої сторінки 

буде менше розмірів аркуша паперу, то навколо ілюстрації будуть чисті поля. 

Підказка 

Розмір друкованої сторінки доцільно ставити, виходячи з розмірів майбутньої 

ілюстрації, а не стандартних аркушів паперу. У разі друку, наприклад, листівок або візитних 

карток такий підхід дозволить вивести на один аркуш паперу кілька копій або сторінок 

документа CorelDRAW. 

Щоб задати нестандартні габарити друкованої сторінки, введіть їх значення в лічильники 

Paper Width and Height (Ширина і висота аркуша), розташовані праворуч від списку форматів 

паперу. Для зміни орієнтації друкованої сторінки клацніть на одній з розташованих ще правіше 

кнопок Portrait (Книжкова) і Landscape (Альбомна). На цих кнопках зображений прямокутник 

сторінки, розташований відповідно вертикально або горизонтально. Можливо, буде потрібно 

змінити і одиниці виміру, які CorelDRAW використовує для визначення координат і розмірів. 

Щоб змінити одиницю вимірювання, виберіть потрібний варіант у списку Drawing Units 

(Одиниці виміру). 
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Практична робота 1. СКЛЯНІ КНОПКИ, СТВОРЕННЯ ROLLOVER`А 

 

Йтиметься про створення скляних напівпрозорих кнопок. На перший погляд може 

здатися, що цей ефект створений за допомогою 3D-програм, але насправді ви можете добитися 

такого ефекту, використовуючи всього лише два-три правильно налаштованих векторних 

об'єктів. У цьому уроці ви навчитеся створювати скляні об'єкти в CorelDraw. 

 
Намалюйте коло діаметром 50 мм (Ellipse tool), утримуючи Ctrl. 

Виберіть інструмент Interactive Fill tool (G), в меню властивостей виберіть тип заливки 

Radial, а колір жовтий і білий. 

 
Для точної настройки градієнта використовуйте діалогове вікно Fountain Fill (F11), 

виберіть пункт Custom. Виділіть крайній лівий колірний маркер і натисніть кнопку Other, щоб 

отримати доступ до більшої кількості кольорів. Виставите колір C40, M50, Y100, K20. Потім 

так само виділіть крайній правий маркер і встановіть колір C0, M0, Y100, K0. Подвійним кліком 

додайте два нових маркера в положення 25% і 80% і встановіть кольори C0, M5, Y100, K20 і C0, 

M0, Y100, K0 відповідно. 
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Для ефекту блику створіть другу окружність приблизно 30мм в діаметрі, залийте білим 

кольором і розмістіть в вгорі і в центрі великого кола, трохи нижче його краю. Не знімаючи 

виділення, застосуєте Interactive Transparency Tool. Тягніть маркер зверху окружності на три 

чверті вниз. 

 
Тепер на основі розглянутих кроків ми створимо скляні кнопки. 1. Намалюйте 

прямокутник (Rectangle Tool, F6) приблизно 115х30мм. (Пропорції прямокутника залежать від 

тексту, який ви хочете помістити на кнопці). 2. Виділіть прямокутник і закруглите у нього всі 

кути за допомогою введення значення 100% в полях Rectangle Corner Roundness в верхньому 

меню. Зверніть увагу, що замочок Round Corners Together потрібно включити. Ви також можете 

скруглить кути вручну, потягнувши їх інструментом Shape.  
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Намалюйте ще один прямокутник розміром приблизно 100х13мм, закруглiть у нього 

кути, залийте білим кольором, видаліть обведення і розмістіть його поверх першого по центру і 

вгорі, як показано нижче. 

 
Вибравши Interactive Transparency Tool потяніне мишкою зверху вниз, щоб застосувати 

прозорість. В меню властивостей встановіть для параметра Edge Pad 8%. 

 
Для створення ефекту Rollover ми будемо використовувати Internet Toolbar. 

1. Розгрупуйте елементи створеної на попередніх етапах кнопки (Ctrl + U). 

2. Виберіть Interactive Drop Shadow Toolі клікніть на нижньому прямокутнику. 

Утримуючи Ctrl, потягніть від центру до низу. Таким чином ви застосуєте тінь з параметрами за 

замовчуванням. У меню властивостей встановіть зміщення по X = 0, по Y = -0.7мм, прозорість 

(opacity) 80, розмиття (feathering) 7; колір тіні виберіть cyan. 
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Для того, щоб переключити активний стан на перекриття мишкою, виберіть у 

випадаючому меню Over. Виділіть напис і змініть її колір. У цьому прикладі був обраний білий, 

щоб при наведенні мишкою на кнопку, її текст підсвічували. 

 
Тепер перейдіть в активний стан натискання мишкою на кнопку - Down. Інструментом 

Pick Tool клікніть на тіні і в меню Effect виберіть Clear Drop Shadow. Цією дією ви видалите 

тінь від кнопки. Залишаючись в режимі редагування стану Down, виділіть всі об'єкти і 

відкрийте докер трансормаціі розташування об'єктів (Arrange> Transformations> Position, Alt + 

F7). 

Введіть значення H = 0, а V = -0.7мм і натисніть Apply або Enter. Як ви пам'ятаєте, такі 

значення ми вводили для ефекту тіні, а значить зараз ми зміщуємо кнопку на те саме місце, де 

знаходилася тінь. 

 
Закрийте вікно трансформації і натисніть на Finish Editing Rollover в меню веб-

інструментів. Rollover готовий. Щоб переглянути результат, досить включити параметр Live 

Preview of Rollovers. 
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Практична робота 2. СТВОРЕННЯ СКЛАДНИХ ОБ’ЕКТІВ 

 

Сьогодні будемо вчитися малювати маленьку симпатичну божью корiвку ось таку ось. 

 
1) Малюємо форми тіла, голови і крил. Малюємо опорні напрямні і овал. Копію овалу 

зрушити по вертикалі (Рис. а). Виділити обидва овалу і кнопкою Перетин  створити об'єкт 

форми голови (верхній овал можна видалити) (Рис. б). Скопіювати "голову" 2 рази, одну копію 

зрушити в сторону, поєднати центри двох об'єктів голови (команди Упорядкувати - 

Вирівняти і розподілити), у одного з цих об'єктів встановити масштаб (на панелі параметрів) в 

110% (Рис. в). Виділити обидва об'єкти і кнопкою Передні мінус задні  (на панелі 

параметрів) створити заготовку до форми крил. Виділити цю криву і кнопкою Перетин 

створити новий об'єкт (Рис. г) (попередню заготовку можна видалити). Інструментом 

Форма  виділити групу "зайвих" вузлів і видалити їх. Інструментом Пряма через 2 

точки  доповнити форму крил, а кнопкою Об'єднання  на панелі параметрів об'єднати ці 

криві в одну форму крил (Рис. д) 

 
а)                                 б)                                                        в) 

                                     

г)                                                            д) 

2) Прорисовуємо форму головки жука. Малюємо "краплю" інструментом Еліпс, Пряма 

через 2 точки і кнопкою Об'єднання (Рис. а). "Краплю" скопіювати, відобразити по 

горизонталі, поєднати центри по вертикалі (Рис. б) і також об'єднати. Скопіювати цей об'єкт і 

встановити масштаб x = 64%, y = 24% (Рис. в). Виділити всі об'єкти, встановити кут повороту 
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на панелі параметрів , інструментом Форма доопрацювати форму крил і голови для 

ефекту перспективи (пересунути деякі вузли) (Рис. г). 

     

         а)                       б)         

                                                           в)                                    г) 

3) Колір тіла жука. Копіюємо еліпс форми тіла 2 рази, масштаб однієї копії 95%, інший - 

60%. Прибираємо у всіх абрис (це необхідна умова для інтерактивного перетікання). Заливаємо 

їх відповідно квітами палітри CMYK (35; 100; 98; 2), (7; 95; 93; 0), (0; 60; 80; 0). 

Примітка. Для відкриття більш детальної палітри, яка зображена на малюнку, необхідно 

утримати ліву кнопку миші на обраному кольорі пару секунд для відкриття палітри відтінків 

цього кольору. 

 
Перший темніший еліпс буде служити нам підставою, його ми не чіпаємо. 

Поєднуємо центри 2 і 3 еліпса: виділити їх, команда Впорядкувати - Вирівняти і 

розподілити. Накладаємо 2 останніх еліпса один на одного (<Ctrl> + <PageUp>) переміщує 

об'єкт на один шар вище і (<Ctrl> + <PageDown>) на один шар нижче. 

За допомогою клавіші <Shift> виділяємо обидва об'єкти і далі використовуємо 

інструмент Інтерактивне перетікання . Число кроків між фігурами при перетікання 

залишаємо за замовчуванням - 20. Після настройки інструменту необхідно задати напрямок 

перетікання. Це перший спосіб здійснити інтерактивне перетікання. 

 
Другий спосіб здійснити інтерактивне перетікання: 

Включити меню Вікно - Вікна настройки - Перетікання. Воно з'являється в бічній панелі 

палітр. 

Виділяєте необхідні об'єкти, з якими потрібно здійснити перетікання і натискаєте кнопку 

"Прийняти". 
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Примітка. У диспетчері об'єктів можна переміщати виділений об'єкт на один шар вище 

або нижче. 

Тепер вийшов об'єкт накладаємо на третій овал, який більше попередніх, його 

поміщаємо під отримані перетіканням форми, він буде служить якійсь обведенням і 

підкреслювати форму черевця. 

Знову копіюємо 2 базових овалу форми тіла. На обидва застосовуємо інструмент 

Інтерактивна прозорість . В налаштуваннях даного інструменту для першого овалу 

вибираємо тип - базову напівпрозорість з режимом множення 75%. Для другого об'єкта 

використовуємо тип - лінійної напівпрозорості з режимом множення. Накладаємо отримані 

фігури поверх заготовки для комашки вище всіх шарів. 

 
А це варіант малювання мордочки від Ser'a: не забудьте спочатку перевести еліпс в криві 

правою кнопкою миші. 

 
4) Далі малюємо ніжки і вусики нашої комашку. Інструментом Художнє 

оформлення , налаштовуємо параметр Кисть 

 
Заливаємо об'єкти чорним кольором, поверх них тим же інструментом малюємо ще 

об'єкти, використовуємо з палітри відтінки сірого. Кожну лапку окремо з розташованими на ній 
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об'єктами групуємо (виділяємо і натискаємо праву кнопку миші Група (Ctrl + 

G)).  

Крупний план ніжок: 

5) До кожній лапці і вусику комашки застосовуємо тінь  з настройками, як показано 

на малюнку. 

 

 

6) Інструментом Крива через 2 точки  прорисовуємо зазор на крилах (об'єкт 

заливаємо чорним і об'єднуємо з "головою"). 

 
7) Колір крилець. Дублюємо об'єкт форми крил. Нижній - CMYK (1; 45; 83; 1), верхній - 

CMYK (19; 100; 82; 67). Нижній злегка зрушуємо вправо і вниз. Згрупуємо об'єкти. 

Примітка: об'єкти і порядок їх розташування. 

 
8) Тепер виділяємо спинку (підстава) і також застосовуємо інструмент Тінь з 

настройками, як показано на малюнку. 
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9) Малюємо на спинці плями, еліпси чорного кольору, спотворюючи їх до певної форми 

за допомогою зміни масштабу і повороту. 

 
10) Створюємо відблиск на голові. Дублюємо криву голови, видаляємо вузли головки, 

масштабується 90%, заливаємо білим кольором і застосовуємо інтерактивну напівпрозорість 

лінійного типу з режимом Освітлення. 

  

 
11) Також намалюємо відблиск на спинці. Продублювати овал-основу, смасштабіровать 

на 75%, залити білим кольором. Застосовуємо на неї Інтерактивну напівпрозорість 

радіального типу, нормального (звичайного)) режиму. В налаштуваннях прозорості 

(подвійним клацанням по значку прозорості в рядку параметрів ), з'явиться вікно 

налаштувань прозорості. Міняємо кольору, які стояли за замовчуванням, як показано на 

малюнку. З: виставляємо чорний колір, В: виставляємо білий колір, натискаємо ОК. 

Розміщуємо відблиск на спинці. Поверх цього відблиску також малюємо менший відблиск. 

 
 



18 

 

 
 

12) Намалюємо ще один відблиск з іншого боку спинки комашки. Малюємо об'єкт: 

дублюємо овал основи 2 рази, масштабується один 80%, інший 60%, накладаємо їх один на 

одного і створюємо об'єкт кнопкою Передні мінус задні , як показано на малюнку, 

заливаємо його білим, застосовуємо на нього тінь, у верхньому меню, в налаштуваннях тіні 

виставляємо тип - світіння, колір тіні - білий, далі до цього ж об'єкту застосовуємо 

Інтерактивну напівпрозорість, базового типу 100%. Групуємо всі об'єкти і сонечко готова! 

 
Результат: 

 
Лист 
 

1.  Форма листа складається з 2 кривих. Загнута частина промальована за 

допомогою перетину двох еліпсів і підгонки форми інструментом Форма . Для зображення 

верхньої частини аркуша використовувався інструмент В-сплайн  
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2. Край листа. Нижню частину продублювати 2 рази, першу копію зрушити вгору 

(див. Малюнок), центр другий поєднати з основною. Виділити одну криву нижню основу і ту, 

яку зрушили вгору, кнопкою Передні мінус задні  на панелі параметрів отримуємо об'єкт 

краю листа. 

 
 

3. Так само зробити криві краю верхньої частини аркуша (зліва і справа). 

 
4. Кривими прорисовуємо прожилки знизу і зверху листа. 
 

 

 
 

 

 

 



20 

 

 

5. Елементи листочка: 

 
6. Заливка. 

 

 
7. Також кривими створюємо держак листочка і додамо жучка. 

 
Приклад малювання листочка (алгоритм): 
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Каплі води 

1. Коло (з натиснутою <Ctrl>). Інтерактивна заливка, Радіальна, Кольори: по 

листу (піпеткою) від темного до світлого і білому 

 
2. Продублюємо, зрушимо копію, виділимо обидва об'єкти і продублюємо ще 

раз. 

 

3. На другий копії не знімаючи виділення кнопкою Задні мінус передні  

створюємо "півмісяць" відблиску (залити білим, прибрати абрис). На першій копії видаляємо 

один дубль, поверх ставимо відблиск і теж забираємо абрис. 

 

4. Малюємо ще один відблиск. Овал перетворимо в криву кнопкою , з 

натиснутим <Shift> інструментом Форма виділяємо верхній і нижній вузли, пересуваємо 
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їх трохи вгору (коригуємо).  Також прибрати абрис, залити білим, 

розгорнути, встановити на краплі і додати лінійну прозорість . Згрупувати об'єкти. 

 
5. Малюємо тінь краплі. Великий овал без абрису, градієнтна радіальна 

заливка (колірний перехід як на краплі, білий - в центрі). Розгорнути і "підкласти" під 

краплю. Тепер обрізаємо її по формі краплі. Групу об'єктів Крапля продублювати 

(Правка - Дублювати) без зсуву, виділити одну копію групи і тінь, кнопкою Задні 

мінус передні  обрізати тінь. 

 
6. На основному еліпсі краплі і на тіні встановимо радіальну 

прозорість.  

7. Перемістимо крапельки на лист. 
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Практична робота 3. РОБОТА З ТЕКСТОМ 

 

Простий та фігурний текст 

Необхідність введення в інструментарій художника-оформлювача, дизайнера, 

художника по рекламі засобів автоматизації роботи з текстом не викликає сумнівів. Однак 

якщо при роботі над текстовим документом за допомогою текстового процесора 

першорядну роль відіграє семантична функція тексту (та інформація, яку кодують текстові 

символи), то при включенні тексту в графічне зображення не менш важливою виявляється 

його естетична функція, художнє вплив, який чинять на глядача ті ж символи своїм 

зображенням, кольором, взаємним розташуванням. 

Ця обставина привела до того, що в CorelDRAW є не один, а два класи текстових 

об'єктів, багато в чому схожих, але в той же час чітко помітних - як за своєю структурою, так 

і по поведінці. 

Перший призначений для подання текстів, які відносно невеликі за своїм обсягом (до 

32 000 символів) і можуть піддаватися всім видам перетворення зображень, доступним в 

CorelDRAW. Об'єкти, що відносяться до цього класу, називаються Блоками фігурного тексту 

(artistic text). 

Другий клас об'єктів дозволяє відображати на Рисюнках великі текстові фрагменти - 

до 32 000 абзаців, в кожному з яких може міститися до 32 000 символів (для порівняння 

відзначимо, що в темі 3 цієї книги міститься всього лише близько 300 абзаців, що 

включають в себе в загальній складності приблизно 60 тисяч символів). Такі тексти можуть 

розділятися на окремі структурні одиниці: абзаци, колонки і рамки. Потенційно великий 

обсяг тексту не дозволяє виконувати над цими об'єктами деякі з перетворень. Об'єкти 

подібного класу прийнято називати Рамки простого тексту (paragraph text frame). 

З попередніх уроків нам відомо, що об'єкти CorelDRAW визначаються сукупністю 

атрибутів (значення яких визначають поточний стан об'єкта) і поведінкою (сукупністю 

операцій, які можна виконати з об'єктом, і впливом, яке ці операції надають па атрибути). 

Розглянемо атрибути фігурного і простого текстів, також операції їх редагування і 

форматування. 

Фігурний текст 

У загальному випадку фігурний текст являє собою багаторівневий з'єднаний об'єкт. З 

однорівневими з'єднаними об'єктами ми вже стикалися, коли розглядали криві, що 

складаються з декількох не пов'язаних один з одним гілок, але провідні себе як єдиний 

об'єкт. Якщо такий об'єкт виділити, а потім вибрати команду Arrange> Break Apart (Монтаж 

- Роз'єднати), він перетворюється в звичайні об'єкти. Блок фігурного тексту (іноді для 

стислості його називають просто фігурним текстом) в процесі роз'єднання поводиться 

інакше. Після першого роз'єднання він перетворюється в сукупність фігурних текстів, кожен 

з яких відповідає рядку вихідного фігурного тексту. Роз'єднання рядки дає сукупність слів, і 

тільки роз'єднання слова дає сукупність фігурних текстів, кожен з яких буде 

«елементарним» - роз'єднати його не вдасться, оскільки він складається з однієї молодшої 

структурної одиниці тексту, символу. Структурну організацію фігурного тексту ілюструє 

рис. 3.1. 

 
Рис. 3.1. Ієрархія структурних одиниць фігурного тексту 



24 

 

Можлива і зворотна операція з'єднання блоку фігурного тексту з раніше побудованих 

блоків за допомогою команди Arrange> Combine (Монтаж - З'єднати). 

Атрибути фігурного тексту 

Для кожного з символів (елементарних об'єктів фігурного тексту) визначені 

перераховані нижче атрибути. 

• Гарнітура (font). Гарнітурою називається Рисюнок символів алфавіту, розроблений 

дизайнером шрифту. Кожен символ гарнітури має свій номер. У стандартних текстових 

гарнітурах Рисюнки окремих символів мають однакові номери, тому тексти, що 

представляються в комп'ютері послідовністю чисел, при форматуванні різними текстовими 

гарнітурами відображають в різних видах одні і ті ж букви. Крім стандартних текстових 

гарнітур в CorelDRAW є гарнітури графічних символів, в яких тими ж номерами відповідають 

вже не букви, а графічні зображення (див. Нижче). Щоб гарнітурою можна було скористатися, 

вона повинна бути встановлена в системі Windows. Після цього її ім'я з'являється в списках, 

що розкриваються вибору гарнітур. 

• Кегль (size). Кеглем називається висота символів тексту в пунктах. Іноді поєднання 

гарнітури і кегля називають шрифтом (наприклад, за замовчуванням фігурні тексти 

виводяться шрифтом Avant Garde Bk ВТ 24 пункту). Вплив гарнітури і кегля на зовнішній 

вигляд фігурного тексту ілюструє рис. 3.2. 

 
Рис. 3.2. Вплив гарнітури і кегля на зовнішній вигляд символів фігурного тексту 

• Нарис (style). Шрифтом називають модифікацію Рисюнка символів тексту за рахунок 

зміни товщини штрихів і їх нахилу. Для кожної модифікації художник повинен розробити 

окремий Рисюнок гарнітури, тому число накреслень в різних гарнітурах відрізняється. 

Стандартними накресленнями прийнято вважати звичайне (Normal), курсивне (Normal-Italic), 

напівжирний (Bold) і напівжирне курсивне (Bold-Italic). Приклади накреслень представлені на 

рис. 3.3. 

 
Рис. 3.3. Стандартні зображення тексту 

• Підкреслення (underline), закреслення (strikethra) і надкресленням (overscore). За 

допомогою цих атрибутів описується присутність і характер ліній, що підкреслюють, 

закреслювати або надчеркнвающіх текст. Стандартними наборами ліній, що використовуються 

для цих цілей, в CorelDRAW вважаються тонка одиночна лінія (Sinchaptere Thin), товста 

одиночна лінія (Sinchaptere Thick) і подвійна тонка лінія (Double Thin). Для кожного з наборів 

передбачена модифікація, що дозволяє підкреслювати тільки текст без пробілів (відповідно 

Sinchaptere Thin Word. Sinchaptere Thick Word і Double Thin Word). На рис. 3.4 представлені 

стандартні варіанти підкреслення. Відзначимо, що в CorelDRAW можна змінювати параметри 

стандартних наборів ліній (товщину, відстань від базової лінії тексту, величину просвіту між 

подвійними лініями). 
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Рис. 3.4. Стандартні варіанти підкреслення 

• Літери (uppercase). Цей атрибут управляє відображенням символів з урахуванням 

перетворення регістру. Він може приймати три значення: без перетворення (None), капітель 

(Small CAPS) і капіталізація (All CAPS). При включенні перетворення капітелі усі Рисі 

символи мають звичайну висоту, але по Рисюнку збігаються з відповідними великими 

символами. Перетворення капіталізації відображає замість Рисих символів їх прописні 

аналоги в висоту прописних символів. Установка будь-якого із значень атрибута не змінює 

символів в самому тексті - змінюється тільки спосіб їх відображення. 

 
• Режим індексу (position). Цей атрибут управляє перетворенням символів при 

відображенні в верхні (надрядкові) або нижні (підрядкові) індекси. 

 
• Зміщення символів (character shift). У цю групу входять три атрибути: зсув по 

горизонталі (Horizontal), зміщення по вертикалі (Vertical) і зміщення кутова (Rotation). Значення 

цих атрибутів задають величини зміщення символів при відображенні в блоці фігурного тексту 

щодо їх «штатного» положення. На рис. 3.5 в верхньому рядку для деяких символів змінено 

зміщення по вертикалі, в середній - по горизонталі, в нижній - для однієї літери введені 

додаткові горизонтальне і вертикальне зміщення і заданий поворот на 160 °. 

 
Рис. 3.5. Зсув символів з вихідних положень 

Для блоку фігурного тексту в цілому визначені наступні атрибути. 

Створення блоку фігурного тексту 

Як фігурний, так і простий текст в CorelDRAW будуються за допомогою інструменту 

Text (Текст) , але різними прийомами. Панель атрибутів після вибору інструменту Text 

(Текст) представлена на рис. 3.6. 

 
Рис. 3.6. Панель атрибутів для інструменту Text 
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Щоб почати введення блоку фігурного тексту, досить клацнути мишею в тій точці 

сторінки, де має розміститися текст. На сторінці з'явиться текстовий, курсор у вигляді 

вертикальної риси. Якщо включений режим відображення недрукованих символів, то після 

введення першого символу нового блоку з клавіатури слідом за ним з'явиться символ кінця 

абзацу  (який в блоці фігурного тексту виробляє тільки переклад на наступний рядок, 

оскільки в фігурному тексті абзаци не виділяються). При необхідності переходу на новий 

рядок слід натиснути клавішу <Enter>. 

Особливу роль відіграє кнопка Форматування символів  (або Властивості 

тексту ) - вона відкриває палітру Format Text (Форматування тексту), що надає 

користувачеві доступ до всіх засобів форматування фігурного тексту, в тому числі до тих з 

них, які недоступні на панелі атрибутів (рис. 3.7) . 

 
Рис. 3.7. Палітра Форматування символів 

Щоб прискорити процес введення (особливо на повільних комп'ютерах) при 

необхідності імпортувати текст у новостворюваний блок фігурного тексту, можна 

скористатися вікном, яке розкривається після клацання на кнопці режиму введення та 

редагування на панелі атрибутів  (Рис. 3.8.). Розташовані у верхній частині цього 

діалогового вікна елементи управління дублюють відповідні елементи управління панелі 

атрибутів і дозволяють призначати формат знову вводиться тексту в процесі введення, не 

закриваючи діалогове вікно. 

 
Рис. 3.8. Вікно редагування тексту 

• Import (Імпорт). Ця кнопка розкриває діалогове вікно вибору текстового документа, 

вміст якого після завершення імпортування буде додано в місці розташування курсора до 

наявного до цього моменту в блоці тексту. У комплект поставки CorelDRAW входять фільтри, 

що дозволяють імпортувати тексти, представлені в файлах більшості поширених форматів. 

• Options (Додатково). Клацання на цій кнопці розкриває контекстне меню (рис. 3.9), що 

дає доступ до допоміжних інструментів для роботи з текстом, аналогічним наявними в будь-

якому досить розвиненому текстовому процесорі. 
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Рис. 3.9. Контекстне меню допоміжних інструментів для роботи з текстом 

Команда Select All (Виділити все) виділяє весь текст блоку. Друга група команд 

дозволяє виправляти помилки вибору регістра символів при введенні, здійснювати 

контекстний пошук і заміну частин тексту. Третя група команд розкриває діалогові вікна 

перевірки орфографії, перевірки граматики і тезауруса. Ці команди працюють практично так 

само, як в будь-якому текстовому процесорі. Четверта група складається з двох команд, які 

керують відображенням у верхній частині вікна редагування списку вибору гарнітур і 

кнопок форматування. Остання команда контекстного меню дає доступ до діалогового вікна 

налаштування параметрів інструменту Text (Текст). 

Більшість прийомів редагування і форматування тексту не надто відрізняються від 

прийомів роботи з текстовим процесором. 

 

3.1. Введення, редагування та форматування фігурного тексту 

Виконуючи цю вправу, ми познайомимося з прийомами створення, з'єднання і 

роз'єднання блоків фігурного тексту, а також з прийомами форматування і редагування їх 

вмісту. 

1. Новий документ. Інструмент Text (Текст) і клацніть мишею в лівому верхньому 

кутку сторінки. На панелі атрибутів виберіть гарнітуру, яка містить символи кирилиці 

(наприклад, Arial), встановіть кегль 48 і введіть з клавіатури наступний текст, розділяючи 

рядки натисканням клавіші <Enter>: 

Жили у бабусі Два веселих гуся: Один - сірий, інший - білий. Два веселих гуся. 

2. У вікні редагування тексту клацніть на кнопці режиму відображення недрукованих 

символів  і зверніть увагу на те, що замість пробілів виводяться Рисенькі гуртки на 

середині висоти рядка, а на кінцях рядків з'явилися символи кінця абзацу. Скопіюйте три 

останні рядки. Як бачите, операції введення і копіювання тексту не відрізняються від що 

застосовуються при роботі з текстовим процесором. 

3. Тепер вставимо в текст спеціальний символ. Встановіть текстовий курсор після 

слова «сірий», і відкрийте пристиковуватися вікно Insert Character (Вставка символу) 

командою Text> Insert Character (Текст - Вставка символу). У списку палітри виберіть 

назву гарнітури - Animalsl (якщо ця гарнітура не встановлена на вашому комп'ютері, її 

можна знайти в комплекті поставки CorelDRAW), а в розташованій нижче палітрі знайдіть 

зображення потрібного символу - в даному випадку, гусака (рис. 3.10). Натиснути кнопку 

Вставити. Змінимо заливку символу: виділити його і клацнути мишею на зразку екранної 

палітри з сірим кольором. 

Примітка 

Тим же способом в фігурний текст можна вставити не тільки символи спеціальних 

гарнітур, але і будь-який векторне зображення. Для цього потрібно вибрати його, 

скопіювати в буфер обміну (<Ctrl> + <c>), вибрати інструмент Text (Текст), поставити 

курсор всередину тексту, і вставити з буфера обміну (<Ctrl> + <v>). Перед вставкою розміри 
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зображення будуть приведені до розмірів символу поточного шрифту, і в подальшому зміни 

кегля тексту будуть впливати на висоту вставленого таким чином зображення. Такі 

зображення називаються вкладеними в текст. Редагувати подібне зображення стандартними 

прийомами CorelDRAW можна. 

 
Рис. 3.10. Палітра Вставка символу в фігурний текст 

4. Точно так же вставте в кінець наступного рядка ще одного гусака, виділіть її та 

натисніть на білому зразку екранної палітри - гусак стане білим. Перейдіть у вікно 

редагування тексту клацанням на відповідній кнопці панелі атрибутів . Вибравши команду 

Options> Replace Text (Додатково - Замінити текст), відкрийте діалогове вікно контекстної 

заміни і замініть всі входження слова «веселих» словом «ненудних», ввівши відповідні 

значення в поля діалогового вікна і клацнувши на кнопці Replace All (Замінити всі). 

5. Виділяючи окремі, довільно вибрані частини інструментом Text (Текст), змініть їх 

кеглі та гарнітури. Перевірте, який вплив чинять на фігурний текст кнопки режимів 

вирівнювання. Скористайтеся палітрою форматування для установки значення кернинга 

рівним 120% від кегля. 

6. На закінчення роз'єднати блок фігурного тексту. Оскільки цей блок нам ще 

знадобиться в цілому вигляді для наступних вправ, підготуйте його копію. Зверніть увагу на 

розташування маркерів рамки виділення (вони розташовуються по краях блоку фігурного 

тексту) і на текст в рядку стану. Виберіть команду Arrange> Break Apart (Упорядкувати  - 

Роз'єднати). Тепер маркери рамки виділення охоплюють тільки перший рядок колишнього 

блоку фігурного тексту. Повторіть операцію роз'єднання ще два рази, розбиваючи рядок на 

слова, а потім - слово на окремі символи. При цьому кожен раз в результаті роз'єднання 

виходять блоки фігурного тексту. 

 
Рис. 3.11. Фігурний текст. Вправа. 
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Підказка 

Роз'єднання блоків фігурного тексту найчастіше доводиться виконувати перед їх 

перетворенням в криві. Таке перетворення часто призводить до появи з'єднаних кривих з 

величезною кількістю вузлів, з якими навіть потужні комп'ютери справляються з великими 

труднощами, не кажучи вже про практично неминучих в цьому випадку проблеми при 

друку. Тому намагайтеся, щоб в які утворюються об'єктах було не більше 400-500 вузлів. 

Простий текст 

Так само як фігурний, простий текст являє собою багаторівневий з'єднаний об'єкт, але 

рівнів, які простий текст проходить при роз'єднанні, більше, ніж у фігурного тексту. При 

роз'єднанні великого обсягу простого тексту можуть виходити такі структурні одиниці: 

колонки тексту, пункти перерахування, абзаци, рядки, слова, символи. Крім того, на відміну 

від фігурного тексту простий текст не може розташовуватися безпосередньо на друкованій 

сторінці. В CorelDRAW будь-який простий текст розташовується всередині особливого 

об'єкта - Рамки простого тексту (paragraph text frame). За допомогою зв'язків рамки можуть 

утворити складений об'єкт - ланцюжок рамок простого тексту, окремі елементи якої можуть 

розміщуватися навіть на різних сторінках документа CorelDRAW. 

 
Рис. 3.12. Ланцюжок рамок простого тексту. Зв'язки рамок відображені у вигляді стрілок. 

Базова форма рамки простого тексту - прямокутник, але в процесі подальших 

перетворень ці прямокутники можуть приймати довільні форми (рис. 3.12) .Такий підхід 

може здатися дивним користувачам текстового процесора, в якому рамки зазвичай 

використовуються для виділення на сторінці місця для Рисюнка або діаграми. 

Засобами CorelDRAW цілком можна зверстати і підготувати до друку невелике 

книжкове видання, але щоб повністю описати процес верстки і всі можливості CorelDRAW в 

цій області, знадобиться ще один підручник! Будемо дотримуватися концепції, що в 

CorelDRAW головне - це ілюстрації, і обмежимося описом основних можливостей і 

прийомів роботи з простими текстами. 

Створення та редагування простого тексту 

Простий текст створюється за допомогою того ж інструменту, що фігурний, а саме - 

інструменту Text (Текст)  з одним попередніми дією - створенням рамки простого тексту. 

Тому після вибору інструменту Text (Текст) в наборі інструментів слід перемістити курсор 

миші в точку, де передбачається розмістити один з кутів майбутньої рамки, і перетягнути 

його по її діагоналі. Після відпускання кнопки миші па екрані з'явиться зображення рамки 

обраних габаритів, усередині якої розташується текстовий курсор у вигляді вертикальної 

риси. Можна приступати до введення тексту з клавіатури. 
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При введенні простого тексту поведінку CorelDRAW інше, ніж при введенні 

фігурного тексту. По-перше, перехід на новий рядок визначається вже не користувачем, а 

автоматично, у міру досягнення текстом правої межі рамки, причому натискання клавіші 

<Enter> означає перехід не до наступного рядка, а до наступного абзацу, який є більш 

великої структурною одиницею тексту, ніж рядок. По-друге, коли текст, що вводиться 

досягне нижньої межі рамки, текстовий курсор пропадає і знову вводиться тексту більше не 

видно. На цьому годі було, що текст не вводиться - він лише не відображається в межах 

рамки. 

Через цих особливостей при введенні значного об'єму простого тексту зручніше 

користуватися діалоговим вікном Edit Text (Редагування тексту), яке відкривається після 

клацання на відповідній кнопці панелі атрибутів - . 

Підказка 

Якщо для роботи над зображенням потрібно простий текст великого обсягу, зручніше 

вводити його за допомогою текстового процесора, а згодом імпортувати в CorelDRAW, 

скориставшись кнопкою Import (Імпорт) діалогового вікна Edit Text (Редагування тексту). 

При імпортуванні тексту, підготовленого за допомогою текстового процесора, можна 

зберегти вихідне форматування абзаців і символів, тільки форматування символів або 

вставляти імпортований текст як послідовність символів, що не має власного форматування. 

Щоб відредагувати простий текст, можна або клацнути на ньому покажчиком 

інструменту Text (Текст), після чого всередині рамки з'явиться текстовий курсор, або 

клацнути на рамці покажчиком інструменту Pick (Вибір) і скористатися діалоговим вікном 

Edit Text (Редагування тексту), розкривши його клацанням на кнопці панелі атрибутів. 

Створення ланцюжка пов'язаних рамок 

Ланцюжками пов'язаних рамок простого тексту користуються для того, щоб 

розмістити один текстовий фрагмент в декількох місцях однієї сторінки або на різних 

сторінках документа. Мова йде не про розміщення копій, а про продовження тексту при 

переході з однієї рамки в іншу (див. Рис. 3.12). 

Якщо текст, що міститься в рамці, відображається в ній не повністю, то індикатор, 

розташований в середині нижньої межі рамки, набуває вигляду прямокутника зі стрілкою, 

спрямованої вниз. Після клацання мишею на цьому індикаторі покажчик інструменту 

приймає форму листа з текстом, він як би «заряджається» текстом. 

 
Щоб додати в ланцюжок нову рамку, залишається тільки перемістити покажчик по її 

діагоналі (рис. 3.13). 

 
Рис. 3.13. Новостворена рамка простого тексту з'єднується стрілкою зі своєю попередницею в 

ланцюжку 
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Рамки, що входять до складу одного ланцюжка, з'єднуються кольоровими стрілками, 

які відображаються тільки па екрані, а на друк виводяться. За формою верхніх і нижніх 

індикаторів можна судити про місцезнаходження рамки в ланцюжку і наявності в ній 

нерозміщення тексту. У першій рамки ланцюжка верхній індикатор порожній . Якщо 

рамка в ланцюжку не остання, її нижній індикатор виглядає як мініатюрна сторінка з 

текстом ; якщо рамка не перша в ланцюжку, її верхній індикатор виглядає як мініатюрна 

сторінка з текстом . Нарешті, якщо рамка остання, її нижній індикатор порожній або 

містить в собі стрілку, спрямовану вниз (якщо є нерозміщений текст) . 

Якщо необхідно, щоб наступна рамка в ланцюжку Риса форму, відмінну від 

прямокутника, слід спочатку побудувати замкнутий криволінійний об'єкт бажаної форми, а 

потім «зарядити» покажчик інструменту текстом, клацнувши на нижньому індикаторі 

останньої рамки ланцюжка. Тепер при переміщенні покажчика всередину замкнутого 

криволінійного об'єкту він прийме форму широкої стрілки, направленої вправо. 

. 

Після клацання на об'єкті таким дороговказом створюється рамка, що збігається з 

об'єктом за формою, - текст полягає всередину об'єкта (рис. 3.14). 

 
Рис. 3.14. Створення рамки простого тексту довільної форми 

Примітка 

В результаті описаної вище процедури створюється складений об'єкт, що складається 

із замкнутої фігури (керуючий об'єкт) і прямокутної рамки, укладеної в оболонку, за 

формою збігається з керуючим об'єктом (оболонки розглядаються в наступних уроках). 

Після побудови рамки в оболонці керуючий об'єкт більше не потрібен, так як на відміну, 

наприклад, від суперлінії його зміна не впливає на форму рамки простого тексту, укладеної в 

оболонку. Тому складений об'єкт можна відокремити командою Arrange> Break Apart 

(Упорядкувати - Роз'єднати простий текст всередині шляху) і видалити замкнуту криву. 

При цьому рамка в оболонці залишається в складі ланцюжка рамок простого тексту. 

Якщо після «зарядки» покажчика інструменту текстом клацнути нема на замкнутому 

об'єкті, а на розімкнутої кривої, то буде побудована прямокутна рамка простого тексту, за 

габаритами збігається з рамкою виділення кривої, після чого почало потрапив в неї тексту 
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(не далі ніж до першого кінця абзацу) розміщується вздовж цієї кривої, а решта тексту 

залишається нерозміщення (див. рис. 3.12). 

Примітка 

У цьому випадку також створюється з'єднаний об'єкт, але іншого типу (текст, 

розміщений на кривій). Тому при відділенні керуючого об'єкта (кривої) рамка простого 

тексту набуває свою початкову прямокутну форму. Таким чином, керуючу криву видаляти 

не можна, але її можна зробити невидимою, скасувавши обведення кривої. 

Щоб видалити рамку, що входить до складу ланцюжка, досить виділити її 

інструментом Pick (Вибір) і натиснути клавішу <Del>. Якщо видаляється остання рамка 

ланцюжка, який містився в ній текст буде витіснений в передостанню рамку, зберігаючись в 

ній як нерозміщений. При видаленні першої рамки ланцюжка текст витісняється в другу і 

розміщується в ній, з другої - в третю і т. Д. Надлишок тексту в ланцюжку завжди 

знаходиться в останній рамці (як нерозміщений текст). При видаленні проміжної рамки 

ланцюжка автоматично створюється нова зв'язок, що з'єднує попередню їй рамку і наступну 

за нею рамку. Текст з віддаленої рамки витісняється «вниз» по ланцюжку. 

Побудований ланцюжок пов'язаних рамок простого тексту можна «розчепити» в 

будь-якому місці. Для цього достатньо описаним вище прийомом «зарядити» покажчик 

інструменту текстом, клацнувши на нижньому індикаторі рамки, і побудувати нову рамку на 

вільному місці. При цьому весь текст з «хвоста» ланцюжка переноситься в нову рамку, а 

рамки, що входять до складу «хвоста», залишаються порожніми, по зчепленими один з 

одним. Якщо згодом на першій «відчепленої» рамці буде виконаний клацання «зарядженим» 

покажчиком інструменту (у вигляді широкої стрілки), все відчеплені рамки будуть знову 

наповнені текстом. 

Рамки, що входять до складу ланцюжка, можуть розміщуватися на різних сторінках 

документа CorelDRAW. При створенні рамки на іншій сторінці слід після «зарядки» 

покажчика інструменту текстом перейти на цю сторінку і створити на ній нову текстову 

рамку. Якщо потрібно перенести раніше створену текстову рамку на іншу сторінку, 

необхідно спочатку перетягнути її інструментом Pick (Вибір) за межі сторінки на робочий 

стіл, перейти на іншу сторінку і перетягнути туди рамку з робочого столу. 

Так можна розміщувати досить значні обсяги простого тексту в пов'язаної ланцюжку 

рамок, розташованих в межах однієї або декількох сторінок документа CorelDRAW, а також 

на робочому столі. 

Обтікання текстом 

Обтіканням простим текстом називається режим, при якому текст в рамках 

розміщується з урахуванням не тільки конфігурації цих рамок, але і форми об'єктів, що 

перекриваються з рамками ланцюжка. Цей режим включається для всіх об'єктів CorelDRAW, 

у яких атрибут обтікання має значення, відмінне від None (Без обтікання). Цей атрибут може 

бути встановлений за допомогою меню, пов'язаного з кнопкою Wrap Paragraph Text (Стиль 

обтікання об'єкта ) панелі атрибутів (рис. 3.15). Крім пего може здаватися зазор, тобто 

мініРисьна відстань між текстом і обтічним об'єктом. 

 
Рис. 3.15. Меню режимів обтікання простим текстом 
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Всі режими обтікання діляться на дві групи: по контуру об'єкта (в якості кордону 

області, в якій текст не розміщується, виступає межа об'єкта довільної конфігурації) і по рамці 

виділення (в якості кордону області, в якій текст не розміщується, виступає габаритний 

прямокутник об'єкта, збігається за розмірами з його рамкою виділення). Приклади обтікання 

текстом наведені на рис. 3.16 і 3.17. 

 
Рис. 3.16. Обтікання текстом по контуру об'єкта: без обтікання (а), обтікання зліва (б). 

обтікання справа (в), обтікання навколо (г) 

Поєднуючи прийоми включення в ланцюжок рамок простого тексту рамок довільної 

форми і обтікання текстом об'єктів, що перекриваються з рамками, можна домогтися будь-

якого, навіть самого хитромудрого варіанти розміщення тексту, відповідного художньому 

задуму автора. 

 
Рис. 3.17. Обтікання текстом по рамці виділення об'єкта: обтікання зліва (а), обтікання 

справа (б), обтікання навколо (в), обтікання врозріз (г) 

Атрибути простого тексту 

Практично всі атрибути фігурного тексту є і у простого тексту, але за рахунок того, 

що у останнього більше структурних одиниць, на вкладках діалогового вікна Format Text 

(Форматування тексту або Властивості тексту) для простого тексту з'являються додаткові 

елементи управління, які і розглядаються нижче. 

Вкладка Character (Символи) в палітрі Format Text (Форматування тексту) для 

простого тексту виглядає так само, як для фігурного (див. Рис. 3.10). 

На вкладці Paragraph (Абзац) палітри Format Text (Форматування тексту) для 

простого тексту в порівнянні з такою ж вкладкою для фігурного тексту доступні додаткові 

елементи управління (рис. 3.18). 
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Рис. 3.18. Вкладка Paragraph діалогового вікна Format Text для простого тексту 

• Кнопка  задає інтервал між словами,  - інтервал між символами. Ці лічильники 

дозволяють більш гнучко управляти вирівнюванням тексту в режимах Full Justify (По ширині) і 

Force Justify (Повний по ширині), регулюючи щільність верстки тексту (рис. 3.19). 

 
Рис. 3.19. Елементи управління інтервалами для простого текста в допоміжному діалоговому 

вікні 

• Група лічильників Spacing (Інтервали) містить лічильники Before paragraph (Перед 

абзацом) і After paragraph (Після абзацу) , які дозволяють 

створювати просвіти між абзацами, звані в поліграфії відбиття. При роботі з простими 

текстами великих обсягів значення цих атрибутів підбираються разом з іншими атрибутами в 

процесі поліграфічної настройки макета для досягнення найбільшої легкості читання. За 

замовчуванням інтервал перед абзацом встановлюється рівним звичайному міжрядкового 

інтервалу, а після абзацу - рівним нулю. 

• Кнопка Hyphenation Settings (Установки перенесення) відкриває допоміжну палітру, в 

якій містяться перелічені нижче елементи керування процесом переносу слів (рис. 3.20). 

• Прапорець Automatic hyphenation (Автоматична розстановка переносів) включає 

режим переносу для слів простого тексту (за замовчуванням вимкнений) і робить 

доступними інші елементи управління діалогового вікна. 

• Прапорець Break capitalized (Перенесення в словах прописних літер) скасовує 

включений за замовчуванням режим заборони на перенесення для слів з прописних 

символів. 

• Лічильник Відстань від правого поля задає ширину зони перенесення - смуги, що 

примикає до правої кордоні рамки простого тексту. Якщо в процесі верстки слово не 

поміщається в рядок, то в режимі автоматичного перенесення перевіряється, де знаходиться 

початок цього слова. Якщо воно потрапляє в зону перенесення, слово цілком перемішається 

на наступний рядок. Якщо початок слова знаходиться лівіше зони перенесення, робиться 

спроба перенести його частина. 
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Рис. 3.20. Діалогове вікно Перенесення 

Увага 

Чим вже зона перенесення, тим більше буде кількість рядків, що закінчуються знаком 

переносу, і тим щільніше будуть рядки тексту. 

• Лічильник Min. word length (МініРісьная довжина слова) задає мініРісьное кількість 

символів в слові, яке може бути перенесено (за замовчуванням - шість символів). 

• Лічильники Min. characters before (МініРісьное число символів до) і Min. characters 

after (МініРісьное число символів після) задають мініРісьное кількість символів слова, яке 

може залишитися на рядку відповідно до і після знаку переносу. 

• Група лічильників Indents (Відступи) дозволяє задавати втяжки і абзацний відступи. 

• Лічильник Left (Лівий)  задає величину лівої втяжки - відстані від 

лівого краю рамки простого тексту до вертикальної лінії, але якої вирівнюються перші 

символи рядків абзацу (окрім першої, вирівнювання якої задається окремо). 

• Лічильник Right (Правий)  задає величину правої втяжки - відстані від 

правого краю рамки простого тексту до вертикальної лінії, по якій вирівнюються останні 

символи рядків абзацу (окрім першої, вирівнювання якої задається окремо). 

• Лічильник First line (Перший рядок)  задає величину лівої втяжки 

першого рядка. Узгоджено регулюючи значення лівої втяжки для першого рядка і для інших 

рядків, можна управляти величиною абзацного відступу - зміщенням першого символу 

першого рядка абзацу щодо лінії лівої втяжки. 

Увага 

Значення, що містяться в лічильниках групи Indents (Відступи), можуть бути тільки 

позитивними, але слід мати на увазі, що відповідні відстані завжди вимірюються від краю 

рамки до її середині. У цьому CorelDRAW відрізняється, наприклад, від текстового 

процесора Word (і більшості інших), в якому знак при величині втяжки визначає напрямок 

відліку відстані. 

Табуляції 

Позицією табуляції, або табулостопом, називається точка в межах довжини рядка, 

керуюча режимом вирівнювання частини рядка, наступній за спеціальним символом 

табуляції. Працюючи з простим текстом, можна задавати позиції табуляції за допомогою 

координатної лінійки простого тексту і вкладки Tabs (Табуляція) палітри Format Text 

(Форматування тексту), представленої на рис. 3.21. 
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Рис. 3.21. Параметри табуляції палітри Format Text 

У середній частині вкладки розташовується таблиця з характеристиками всіх 

встановлених на поточний момент позицій табуляції. Перший стовпець таблиці вказує 

положення відповідного табулятора. Після клацання мишею в будь-якому осередку цього 

стовпця можна змінити значення безпосередньо в осередку введенням нового числа з 

клавіатури або скористатися кнопками лічильника зі стрілками. 

Клацання в будь-якому осередку стовпця Alignment (Вирівнювання) дозволяє 

розкрити список альтернатив вирівнювання для позиції табуляції: Left (Ліворуч), Right 

(Праворуч), Center (По центру) або Decimal alignment (За десятковій крапці). 

Стовпець прапорців Leadered ( З заповнювачем або Виносні лінії) вказує, чи 

пов'язана позиція табуляції з заповнювачем. Заповнювач являє собою повторювану 

послідовність символів, що заповнюють (замість звичайних прогалин) рядок в проміжку між 

текстами, вирівняними за попередньою та поточною позиціями табуляції. 

 
Для завдання символу-заповнювач потрібно натиснути кнопку Параметри виносної 

лінії і ввести сам символ в текстове поле Character (Між символами). За замовчуванням як 

заповнювач застосовується пробіл. Лічильник Spacing (Інтервал) використовується для 

управління міжсимвольним інтервалом в заповнювачі. 

Примітка 

В межах одного абзацу може використовуватися тільки один варіант настройки 

заповнювач. 
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Щоб додати нову позицію табуляції, досить клацнути на кнопці Add tab (Додати) 

(Рис. 3.21.). Якщо потрібно видалити позицію табуляції, спочатку виділіть відповідну їй 

осередок в таблиці, а потім клацніть на кнопці Delete tab (Видалити). Для видалення відразу 

всіх позицій табуляції клацніть на кнопці Delete All (Видалити все), розташованої в правому 

нижньому кутку діалогового вікна. 

Колонки тексту 

Простий текст, розміщений в межах рамки, можна розташувати в кілька колонок (не 

більше восьми). Колонки тексту можуть бути рівною або різної ширини, вони 

відокремлюються одна від одної середниками - вільним простором, виключеним з процесу 

верстки. Елементи управління, що задають значення атрибутів, що мають відношення до 

колонок тексту, розташовані на вкладці Стовпці палітри Format Text (Форматування 

тексту), представленої на рис. 3.22. 

 

 
Рис. 3.22. Вкладка Стовпці палітри Format Text 

• Лічильник Number of columns (Число колонок) дозволяє задати кількість текстових 

колонок, на яке розбивається простий текст, розміщений в рамці. 

• У стовпці Width (Ширина) можна ввести значення ширини кожної з колонок тексту в 

межах рамки. 

• У стовпці Обкладинка можна вказати відстань між стовпцями. 

• Прапорець Equal column width (Колонки рівної ширини) включає режим, при якому 

атрибути ширини і посередника задаються тільки для першої колонки, а для всіх інших 

автоматично встановлюються ідентичні значення. 

Примітка 

Якщо встановлений перемикач Maintain current frame width (Зберігати ширину рамки), 

то ширина рамки абзацу буде залишатися постійною незалежно від розмірів колонок і 

середників. При установці перемикача Automatically adjust frame width (Автоматично 

змінювати ширину рамки) ширина рамки буде автоматично змінюватися, залишаючись 

рівною загальній ширині колонок і середників. 

На вкладці Кадр палітри Форматування (або Властивості) тексту в списку Vertical 

justification (Вирівнювання по вертикалі) вибирається спосіб розміщення рядків тексту по 

вертикалі в межах колонки. 
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У списку є альтернативи Тор (По верху), Center (По центру), Bottom (По низу) і Full 

(Повний). В останньому випадку інтерліньяж в неповній колонці збільшується таким чином, 

щоб «розтягнути» колонку на всю висоту рамки. 

Примітка 

Зображення в області попереднього перегляду, розташованої в правій верхній частині 

вкладки, змінюється відповідно до обраних значеннями атрибутів колонок тексту. 

Ефекти 

На вкладці палітри Format Text (Форматування тексту) можна встановити марковані 

списки і літери. 

В CorelDRAW є можливість вибрати для виділеного абзацу (або сукупності абзаців) вид 

маркера списку і його розташування щодо тексту. 

• Список Font (Шрифт) дозволяє вибрати гарнітуру, символи якої відображаються в 

розкривається палітрі Symbol (Символ). Щоб вибрати маркер списку, досить клацнути на 

одному з символів, представлених в палітрі. 

 
Рис. 3.23. Вікно настройки маркованого списку 

• Лічильник Size (Розмір маркера) визначає кегль маркера списку. За замовчуванням 

це значення встановлюється рівним кеглю першого символу абзацу. 

• Лічильник Baseline shift (Зсув маркера) визначає змішання маркера списку щодо 

базової лінії першого рядка абзацу по вертикалі. 

• Параметри інтервалу дозволяє задати відстань від лівого краю рамки простого 

тексту до маркера списку і від маркера до тексту. 

Примітка 

Якщо абзацний відступ перевищує цю відстань, то текст абзацу маркованого списку 

розміщується так само, як без маркера. В іншому випадку перший рядок абзацу додатково 

зміщується вправо, звільняючи місце для маркера списку. 
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Прапорець Використовувати стиль відступу для списків з маркерами, управляє 

розташуванням маркера списку щодо тексту маркованого абзацу: 

 
У поліграфії буквицей називається перший символ абзацу, виділений дуже великим (у 

порівнянні з тілом абзацу) кеглем і розташований особливим чином по відношенню до 

решти тексту абзацу. В CorelDRAW є маса можливостей для художнього оформлення 

буквиц у вигляді зображень, але слід мати на увазі і можливість вдатися до традиційного 

друкарського прийому. 

 
Після вибору альтернативи Drop cap (Буквиця) в палітрі Форматування або Властивості 

тексту можна відкрити вікно її налаштування (Рис. 3.24.). 

 
Рис. 3.24. Елементи управління форматуванням літери 

• Лічильник Число рядків визначає кількість рядків тексту, сукупна висота яких 

буде прийнята за висоту літери. 

• Лічильник Distance from text (Відстань до тексту) визначає інтервал між 

правим краєм літери і текстом абзацу. 

Прапорець Використовувати стиль відступу для буквиці управляє режимом 

розміщення літери по відношенню до абзацу аналогічно маркованому списку. 
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3.2. Робота з простим текстом 

В якості вправи для освоєння прийомів роботи з простим текстом створимо 

макет умовного меню ще більш умовного кафе. Вид макета представлений на рис. 3.25 

- як бачите, ми поки не дуже піклуємося про його художні достоїнства. 

Щоб не сковувати творчу фантазію, наведемо лише найзагальніші вказівки по 

етапах роботи. 

1. Розподіляємо напрямні для заголовка. 

2. Рисюємо саквояж. Крапля для боковинки: коло + інструмент Пряма через 2 

точки , виділити їх, кнопкою Створити кордон  на панелі параметрів 

створюємо об'єкт контуру цих двох об'єктів, після чого їх можна видалити. 

 
1. Скопіювати краплю 2 рази. Одна - другий край саквояжа, інша - 

(зменшити вдвічі) складка. 

   

2. Ліву частину саквояжа скопіювати, інструментом Пряма через 2 точки, 

з'єднати краплі, використовуючи параметр Роз'єднати криву видалити зайві частини 

кривих і створити об'єкт кнопкою Створити кордон. Підібрати заливку для корпусу 

і боковинки саквояжа. 

  

3. Прямокутником створюємо замок. 

4. Ручка валізи. Еліпс, скопіювати, зменшити (80%), об'єднати центри 

(команди Упорядкувати - Вирівняти і розподілити), кнопка Задні мінус 

передні , Заливка. Основа для заголовка меню готова. 
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1. Тексти заголовка. 

  

2. Зробити розмітку і створити рамку простого тексту. 

 
3. Створити текстовий шаблон для одного віконця. 

4. Скопіювати, заповнити всі віконця меню. 

 
5. Використовуючи режим Розпилювача інструменту Художнє оформлення додати 

графіки. 
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Рис. 3.25. Макет меню 

 

Взаємні перетворення фігурного і простого тексту 

Фігурний текст можна перетворити в простий. При дотриманні певних умов можливо і 

зворотне перетворення - блоку простого тексту в текст фігурний. 

Щоб перетворити фігурний текст в простий, слід виділити його за допомогою 

інструменту Pick (Вибір), а потім вибрати команду Text> Convert To Paragraph Text (Текст - 

Перетворити в простий текст). 

Щоб перетворити простий текст в фігурний, слід виділити його за допомогою 

інструменту Pick (Вибір), а потім вибрати команду Text> Convert To Artistic Text (Текст - 

Перетворити в фігурний текст). 

У тих випадках, коли перетворення можливо, на панелі атрибутів доступна відповідна 

кнопка. 

Примітка 

При перетворенні простого тексту в фігурний втрачаються атрибути, відсутні в об'єктах 

цього класу, а саме: колонки тексту, позиції табуляції літери. У тих випадках, коли в рамці 

простого тексту є нерозміщений текст, або вона входить до складу ланцюжка рамок, або до неї 

було застосовано спеціальне перетворення (наприклад, розміщення тексту по кривій), 

перетворення в фігурний текст неможливо. 
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3.3. Розміщення тексту на траєкторії 

• Розміщення тексту вздовж розімкнутої кривої і його відділення від траєкторії 

• Налаштування тексту на незамкненою траєкторії 

• Розміщення кількох текстів на одній траєкторії 

• Розміщення тексту вздовж замкнутої кривої 

Ми можемо зробити з фігурним текстом практично все, що завгодно, довільним чином 

модифікуючи і форму літер, і їх розташування. Однак у практичній роботі наявності 

теоретичної можливості домогтися будь-якого ефекту недостатньо - потрібно, щоб роботу 

можна було виконати досить швидко і просто. Справді: якщо вам, наприклад, потрібно 

розмістити текст рекламного оголошення на завитках панцира равлики, ви можете розбити 

текст на окремі символи, а потім розміщувати і розгортати кожен з них індивідуально. Однак 

якщо в ході роботи над композицією буде потрібно не просто збільшити або зменшити 

зображення равлики, а змінити кількість витків її панцира, вся копітка робота піде нанівець. 

Арсенал засобів, наявних в CorelDRAW, дозволяє стверджувати: якщо на рішення будь-

якої практичної задачі художнього дизайну у вас йде дуже багато сил або часу, швидше за все, 

ви вирішуєте її не кращим способом. У розглянутій вище задачі було б доцільно не дробити 

текст, а розмістити його цілком на траєкторії. В результаті цієї операції утворюється складений 

об'єкт, в якому траєкторія грає роль керуючого об'єкта, а розміщений на ній текст - роль 

підлеглого об'єкта. При цьому текст, розміщений на траєкторії, можна як редагувати, так і 

форматувати, змінюючи більшість його атрибутів. 

У цьому уроці розглядаються прийоми розміщення фігурного тексту на траєкторії і 

налаштування цього розміщення. Як траєкторії розміщення фігурного тексту можуть виступати 

як незамкнуті об'єкти, наприклад лінії, побудовані інструментом Bezier (Крива Безьє), так і 

замкнуті (наприклад багатокутники). Після того як текст розміщений на траєкторії, можна 

виконувати наступні операції форматування, специфічні тільки для складових об'єктів цього 

класу: 

• задавати орієнтацію символів щодо траєкторії; 

• ставити додаткове зміщення базової лінії тексту щодо траєкторії; 

• вирівнювати текст по вертикалі щодо траєкторії по базовій лінії, по середній лінії 

тексту, по його верхнім або нижнім виступаючим елементів; 

• задавати режим розміщення тексту по довжині траєкторії; 

• вибирати, на якій з двох сторін траєкторії розміщувати текст. 

При цьому зберігається можливість виконувати і традиційні для входять до складений 

об'єкт компонентів операції форматування і редагування - можна редагувати текст, змінювати 

його атрибути форматування, а криву, задану траєкторію розміщення тексту, - редагувати за 

допомогою інструменту Shape (Форма) прийомами. При цьому зв'язок тексту, і траєкторії 

зберігається, а необхідні зміни в зображення вносяться автоматично. 

Як всякий складений об'єкт, текст, розміщений на траєкторії, може бути відділений 

командою Break Apart (Роз'єднати), після чого утворюються два окремих об'єкта - текст і 

об'єкт, який виконував роль його траєкторії. Хоча їх зв'язок і втрачається (подальше 

редагування траєкторії не робить впливу на текст), текст зберігає зовнішній вигляд, який він 

мав до відділення від траєкторії. Для його перетворення в звичайний блок фігурного тексту без 

окремої випрямлення. 

Про використання розміщеного на траєкторії тексту в якості однієї з пов'язаних рамок 

простого тексту вже згадувалося. 

Розміщення тексту вздовж розімкнутої кривої і його відділення від траєкторії 

Щоб розмістити знову вводиться з клавіатури текст на заздалегідь побудованої 

траєкторії, слід виконати наступні кроки. 

1. Виділіть майбутню траєкторію інструментом Pick (Вибір). 

2. Виберіть команду Text - Fit Text To Path (Текст - Текст уздовж шляху). 

3. Введіть текст з клавіатури. 
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Те ж саме можна зробити і без вибору команди меню - досить навести покажчик інструменту 

Text (Текст) на будь-яку точку майбутньої траєкторії - так, щоб покажчик інструменту змінив 

свою форму (рис. 3.26, зліва) - і клацнути мишею. Після цього вводиться з клавіатури текст 

буде розміщуватися на траєкторії (рис. 3.26, праворуч). 

 
Рис. 3.26. Розміщення тексту на траєкторії 

Щоб відредагувати текст, розміщений на траєкторії, досить виконати на ньому подвійне 

клацання при обраному інструменті Text (Текст). У тексті з'явиться курсор, після чого текст 

редагують звичайними прийомами. 

Примітка 

На не дуже потужних комп'ютерах рекомендується редагувати текст не безпосередньо на 

траєкторії, а в вікні редагування - не потрібно буде чекати переРисьовування тексту після 

внесення кожного виправлення. 

Щоб відокремити текст від траєкторії, на якій він розміщений, зробіть наступне. 

1. Виділіть складений об'єкт інструментом Pick (Вибір). 

2. Виберіть команду Arrange - Break Text Apart (Упорядкувати - Роз'єднати). 

Щоб зробити відокремлену від траєкторії рядок прямий, слід виділити її інструментом 

Pick (Вибір) і вибрати команду Text> Straighten Text (Текст - Випрямити текст). 

Увага 

Слід мати на увазі, що при розміщенні блоку фігурного тексту на траєкторії з нього 

видаляються спеціальні символи кінця абзацу та переходу на наступний рядок. Через це після 

відділення тексту від траєкторії і його випрямлення завжди виходить тільки один рядок, 

незалежно від того, скільки їх налічувалося в вихідному блоці фігурного тексту. 

Зверніть увагу на вузол-модифікатор, який закриває передню частину початковим 

символом тексту. Перетягуючи цей вузол уздовж траєкторії, можна грубо встановити початкову 

точку розміщення. Для більш точного налаштування необхідні елементи управління панелі 

атрибутів. 

Налаштування тексту на незамкненою траєкторії 

Налаштування керуючих параметрів розміщення тексту на незамкненою кривої 

виконують або відразу ж після побудови складеного об'єкта, або після його виділення 

інструментом Pick (Вибір). 

Примітка 

При виділенні тексту, розміщеного на траєкторії, клацати мишею слід на будь-який з 

літер тексту. При натисканні на траєкторії замість складеного об'єкта в цілому буде виділено 

тільки його керуючий об'єкт - крива, що задає траєкторію. 

Налаштування здійснюється елементів управління, розташованих на панелі атрибутів, 

показаної на рис. 3.27. 

 
Рис. 3.27. Панель атрибутів для тексту, розміщеного на незамкненою кривої 
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• Список Text Orientation (Орієнтація тексту) призначений для вибору варіанту орієнтації 

кожного з символів тексту і їх спотворення в залежності від нахилу і кривизни траєкторії, 

відповідної точці прив'язки цього символу. На рис. 3.28 список представлений в розгорнутому 

вигляді, малюнки першого горизонтального ряду відповідають двом його першим 

альтернативам, другого - двом останнім. 

 
Рис.3.28. Альтернативи списку орієнтації тексту і відповідні їм варіанти розміщення 

• Список Vertical Placement (вертикальне розташування) призначений для вибору 

положення базової лінії тексту щодо траєкторії. На рис. 3.29 цей список представлений в 

розгорнутому вигляді разом з прикладами, відповідними його альтернативам. Перші чотири 

альтернативи (зверху вниз) відповідають поєднанню з траєкторією наступних точок тексту: 

базової лінії тексту, верхніх виступів тексту, нижніх виступів тексту і середини смуги 

інтерліньяжу. Остання альтернатива дозволяє розміщувати текст так, що після утворення 

складеного об'єкта його можна переміщати по вертикалі мишею, регулюючи положення 

базової лінії щодо траєкторії довільним чином. 

 
Рис. 3.29. Альтернативи списку положення по вертикалі і відповідні їм варіанти 

розміщення 

• Список Text Placement (Положення по горизонталі) призначений для вибору положення 

тексту по довжині траєкторії. На рис. 3.30 цей список представлений в розгорнутому вигляді 
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разом з прикладами розміщення тексту, відповідними кожній з його альтернатив. 

 
Рис. 3.30. Альтернативи списку положення по горизонталі і відповідні їм варіанти 

розміщення 

• Лічильник Distance from Path (Зсув по вертикалі) дозволяє точніше задати взаємне 

положення базової лінії тексту і траєкторії. 

• Лічильник Horizontal Offset (Зсув по горизонталі) дозволяє явно задати зміщення точки 

прив'язки початкового символу тексту щодо положення, запропонованого обраної 

альтернативою списку положення по горизонталі. 

Примітка 

Якщо розміщується новий текст, що вводиться з клавіатури після клацання в будь-якій 

точці траєкторії інструментом Text (Текст), значення зсуву по горизонталі автоматично 

формується таким чином, щоб поєднати точку прив'язки першого символу тексту з точкою 

траєкторії, в якій був виконаний клацання. 

• Кнопка Place on Other Side (Розмістити на іншій стороні) дозволяє перемістити текст на 

іншу сторону траєкторії. На рис. 3.31 представлений текст, розміщений на траєкторії до і після 

перенесення на іншу її сторону. 

 

 
Рис. 3.31. Текст до і після переміщення на іншу сторону траєкторії 

З текстом, розміщеним на траєкторії, можна виконувати будь-які операції форматування 

і редагування. Для цього його попередньо слід виділити клацанням миші, утримуючи клавішу 

<Ctrl> - без натискання цієї клавіші буде виділено не текст, а складений об'єкт. Самі операції 

форматування і редагування виконуються так само, як зі звичайним блоком фігурного тексту. 

Слід сказати також про прийом інтерактивної регулювання інтервалів в тексті, 

розміщеному на траєкторії. При виділенні тексту, розміщеного на траєкторії, інструментом 

Shape (Форма) на екрані з'являються стилізовані стрілки для настройки інтервалів і вузли, що 

відповідають точкам прив'язки всіх символів напису. Перетягуючи ці вузли інструментом Shape 

(Форма), можна уточнити розміщення кожного з символів на траєкторії. Перетягування тим же 

інструментом стилізованої горизонтальної стрілки дозволяє задавати міжсимвольні інтервали. 

На рис. 3.32 представлені вихідна напис, розміщена на траєкторії, її варіант зі збільшеним 

міжсимвольним відстанню, а також варіант зі збільшеним межсловних відстанню. 
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Рис. 3.32. Регулювання горизонтальних інтервалів в тексті, розміщеному на траєкторії, 

інструментом Shape 

Примітка 

Щоб перетягування горизонтальної стилізованої стрілки (її видно на рис. 3.32 в правому 

нижньому кутку) призводило до регулюванню не міжсимвольного, а межсловного інтервалу, 

слід перетягувати її, утримуючи клавішу <Shift>. Перетягування вертикальної стилізованої 

стрілки для тексту, розміщеного на траєкторії, не дає ніякого ефекту - в такому тексті немає 

окремих рядків, отже, регулювати межстрочное відстань безглуздо. 

 

Розміщення кількох текстів на одній траєкторії 

Ніщо не заважає використовувати одну криву як траєкторії для розміщення декількох 

текстів. При цьому другий і наступні тексти розміщуються на раніше побудованої траєкторії 

точно так же, як і перший. В результаті в уже існуючий складений об'єкт додаються додаткові 

об'єкти, відповідні розміщеним текстам. На рис. 3.33 представлений такий складений об'єкт, що 

складається з керуючої кривої (траєкторії) і двох розміщених на ній текстів, для більшої 

помітності відформатованих різними гарнітурами. 

 

 
Рис. 3.33. Кілька текстів на одній траєкторії і повідомлення в рядку стану 

У нижній частині малюнка наведено повідомлення, що з'являється в рядку стану при 

виділенні складеного об'єкта інструментом Pick (Вибір). Після того як в складений об'єкт 

вводяться третій і наступні об'єкти, виділяти кожен окремий текст, розміщений на траєкторії, 

стає складніше. Рекомендуються наступні прийоми виділення. 

• Щоб виділити весь складений об'єкт, клацніть на ньому покажчиком інструменту Pick 

(Вибір). Після цього можна, наприклад, перетягнути один з маркерів виділення, і 

масштабування пошириться на всі частини складеного об'єкта, в тому числі спотворяться і 

контури символів всіх текстів. 

• Щоб виділити частину складного об'єкта, що включає в себе тільки один з розміщених 

на траєкторії текстів і керуючу криву, клацніть на будь-якому символі цього тексту 
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інструментом Pick (Вибір), утримуючи клавішу Ctrl. Після цього можна, наприклад, змінити 

положення тільки цього тексту по відношенню до траєкторії. 

• Щоб виділити тільки один текст з числа розміщених на траєкторії, слід виконати 

обидва щойно описаних прийому, а потім ще раз клацнути на що виділяється тексті 

інструментом Pick (Вибір), утримуючи клавішу Ctrl. Буде виділено тільки один текст, після 

чого можна, наприклад, змінити його кегль або гарнітуру або перетягнути маркер-модифікатор, 

зміщуючи текст уздовж керуючої кривої. 

 

Розміщення тексту вздовж замкнутої кривої 

Розміщення тексту на замкнутої траєкторії має деякі особливості. Наприклад, після 

розміщення тексту на замкнутої траєкторії зміст списку Text Placement (Положення по 

горизонталі) на панелі атрибутів стає іншим - його альтернативи, показані на рис. 3.34, 

відповідають вже не варіантам вирівнювання тексту, а чотирьом квадрантам замкнутої кривої: 

верхнього, правого, нижнього і лівого. 

 
Рис. 3.34. Розміщення тексту в різних квадрантах замкнутої траєкторії 

Найзначніше варіанти розміщення тексту на незамкненою і замкнутої траєкторії 

розрізняються в частині перенесення тексту на іншу сторону траєкторії. На рис. 3.35, а 

представлений складений об'єкт, в якому два тексти розміщені відповідно в першому і третьому 

квадрантах однієї траєкторії, заданої окружністю. На рис. 3.35, б представлено зображення 

після виділення нижнього тексту і натиснення на панелі атрибутів кнопки перенесення на іншу 

сторону траєкторії. Нарешті, на рис. 3.35, в представлено зображення після застосування до 

нижнього тексту режиму вертикального положення під траєкторією. 

 
Рис. 3.35. Перенесення тексту на іншу сторону замкнутої траєкторії 

В якості вправи для практичного освоєння прийомів, з якими ми познайомилися в цій 

темі, самостійно побудуйте зображення, представлене на рис. 3.36. Постарайтеся домогтися 

максіРісьной виразності, підібравши гарнітуру, кегль і інтервали тексту і прибравши обведення 

траєкторії. Можливо, вдалим доповненням могла б стати замовна радіальна градієнтна заливка, 

що імітує чорну діру в середині і спокійну блакитну воду по краях (для цього знадобиться 

допоміжний об'єкт - окружність, що охоплює всі зображення). Можливо, до роботи з цим 

малюнком буде доцільно повернутися, ознайомившись з матеріалом наступної теми і освоївши 

прийоми роботи з точковими зображеннями - виразний фон з імітацією виру буде простіше 

побудувати. 
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Рис. 3.36. Розміщення тексту по спіралі 

 

3.4. Створення текстових ефектів 

Ефект об'ємного тексту в векторі 

Кінцевий результат: 

 
Для отримання подібного ефекту «відблисків» на тексті, людині, знайомому з 

CorelDRAW буде потрібно не більше 10-15 хвилин, все маніпуляції стандартними засобами 

програми вимагають лише індивідуального підходу до того чи іншого рішення задачі. 

Для початку, визначившись з розміром і товщиною шрифту потрібно налаштувати 

параметри Nudge Offset (доступна при активному інструменті Pick tool, при відсутності 

виділених об'єктів) і велічену ефекту Contour (докер активізується при натисканні Ctrl + F11 

або через меню Effects), близько 1/10 від середньої товщини елементів букв. 

Nudge Offset дозволить виробляти точні зміщення другорядних об'єктів, це корисно 

коли потрібно застосувати схожі ефекти до інших шрифтів або просто зробити все акуратно і 

рівно. 

 
Попередньо підготовлений текст перекладається в криві (Ctrl + Q), і застосовується 

ефект Contour, потім текст з ефектом розбивається на окремі об'єкти за допомогою меню 

Arrange> Break Apart (Ctrl + K) 

 
Вихідний шрифт дублюється натисканням «+» на цифровій клавіатурі і зміщується 

стрілками вниз і вліво (або навпаки якщо буде потрібно). Інструментом Pick Tool вибираємо 

зміщений шрифт потім (!) З затиснутою клавішею Shift внутрішній контур і виробляємо 

операцію Trim, зміщений дублікат - об'єкт другорядним і більше не потрібен. 

Об'єкти, що залишилися доводяться інсрументом Shape Tool (F10). При цьому слід 

включити функцію Dynamic Guides (Alt + Shift + D), це значно полегшить завдання, всі вузли і 
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лінії переміщуються точно і рівно. Таким чином виходять акуратні 

відблиски.  

Той-таки технікою можна домогтися досить пристойних об'ємних ефектів, тіней і 

рефлексів. Навіть без використання Transparency (прозорості) і Fountain Fill (градієнтної 

заливки), що ні Рісоважно при підготовці зображень до деяких видів друку. 

 

Спотворення тексту 

Отже для початку візьмемо відповідний шрифт (чим вище ступінь спотворення тим 

товщі він повинен бути), наприклад стандартний Arial Black: 

 
Потрібно додати побільше вузлів: перевівши шрифт в криві і виділивши всі вузли два-

три рази натиснути «+» на цифровій клавіатурі, або кнопку Add Node (s) на панелі властивостей 

інструмента Shape Tool.Получітся приблизно так: 

 
Тепер трохи ручної роботи: шейпер потрібно пооттягівать деякі вузли в різні боки, 

виходячи з припущення про майбутнє спотворенні: 

 
Копіюємо текст, виділяємо всі вузли, переводимо їх в криві і за допомогою повзунка 

Curve Smoothness доводимо спотворення до потрібного ступеня: 

 
Трохи з іншими параметрами проробляємо теж саме для копій які накладуться одна на 

іншу: 
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Зображення накладається на текст і командою Intersect або Trim отримуємо щось 

подібне: 

 
Все, «згладжені» з різними параметрами тексти накладаються один на одного, 

розфарбовуються і т.д. і т.п.. 

 
 

Декоративний текст в CorelDRAW 

Сьогодні ми створимо в CorelDRAW напис, прикрашену декоративними елементами. Це 

дуже просто, але нам все-таки буде потрібно невелика допомога Photoshop. 

Кінцевий результат уроку буде виглядати приблизно ось так: 
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Що робити, якщо у вас немає красивих векторних завитків для оформлення тексту і 

немає часу або, як у мене, вміння, щоб їх намалювати? Скористатися кистями для Photoshop! У 

вас напевно є якісь декоративні кисті: завитки, гілочки, квіточки, листочки, плями. 

Отже ви знайшли або встановили кисті. Відкрийте Photoshop. Створіть документ 

розміром приблизно 800 * 800 px, колір полотна білий, CMYK або rgb, дозволом 300 dpi, хоча 

розмір файлу - це абсолютно не принципово, він може бути як більше, так і менше, все 

залежить від розміру кистей. 

Виберіть інструмент Кисть (Brush (B)) і зробіть кілька довільних відбитків різних, 

сподобалися вам кистей, стежачи за тим, щоб малюнки не перетиналися. Втім, можна 

скористатися і однієї-єдиної пензликом і отримати вражаючий результат. Всі відбитки можна 

виконати на одному шарі. 

 
Відкрийте CorelDRAW. Імпорт (File-import) ваш підготовчий файл. А тепер перетворимо 

Растр в вектор. Для початку перетворіть його в двокольорове зображення: меню Bitmaps - 

Convert to bitmap. 

 
У ньому ви можете налаштувати параметри трасування за своїм смаком. Загальні 

поради: збільште Масштаб і перетягніть у вікно перегляду найбільш деталізований ділянку 

Зображення - для цього є кнопки нагорі вікна. Не робіть параметр Smoothing на 0, щоб зберегти 

всі крапки - в такому випадку їх буде дуже багато. Щоб зберегти деталі, скористайтеся 

параметром Detail. 

Після цього у вас вийдуть два Зображення одне на одному (якщо ви звичайно не 

поставили галочку видалити оригінал (Delete original image) в діалоговому вікні). Внизу 

растровий оригінал, зверху група з векторних елементів. Щоб покращити зручно створити 

прямокутник з контрастним фоном і перетягнути на нього нашу векторну групу. (Якщо після 

перетягування візерунки пропадуть - натисніть Ctrl + Page Up, якщо у вас виділений малюнок, 
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щоб підняти його на один рівень вгору або виділіть прямокутник, який перекриває малюнок, 

натисніть Ctrl + Page Down і прямокутник переміститься вниз.) Ось, тепер наочно видно, що на 

малюнку залишилися непотрібні ділянки фону всередині візерунків. 

 
Тепер все залежить від вашої скрупульозності. Якщо ви хочете, щоб завитки були рівні й 

без зайвих точок і заломів - інструмент Shape tool вам на допомогу. Міняйте властивості вузлів 

(наприклад міняйте Cusp на Smooth або навпаки) або властивості ділянок кривої (Line на 

Curve), можна проставити нові точки там, де ви вважаєте за потрібне. 

На нашому форумі є дуже корисний урок, де докладно описані властивості різних вузлів 

і робота з цим інструментом. Вирівнювати вже готовий малюнок - не складно, хоча можна 

взагалі пропустити весь цей етап з трасуванням і намалювати нові візерунки, кому як зручніше. 

 
Додайте ваші векторні візерунки по поверхні тексту, копіюючи (дуже просто: виділіть, 

перемістіть і перед тим, як відпустити ліву, клацніть правою кнопкою мишки), змінюючи 

розмір, відображаючи і розгортаючи їх. Головне в цій справі: пам'ятайте, що після закінчення 

роботи напис повинен читатися. 
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Розфарбуємо наш текст і візерунки. 

Ви можете розфарбувати ваші текст і візерунок як вам завгодно. Візерунки можна 

згрупувати між собою, щоб зміни відбувалися одночасно. Можна виконати заливку одним 

кольором або градієнтом. Різні варіанти забарвлення об'єктів ховаються за кнопкою Fill tool. 

Для тих, хто не знає, як фарбувати фігуру, або як прибрати контур. Справа в вікні програми 

майже завжди є палітра. Якщо її немає, то йдете в меню Window - Color Palettes - default 

CMYK palette (там їх багато, якщо вам потрібна інша - вибирайте потрібну). Коли палітра 

знайдена або з'явилася на екрані, виділяєте об'єкт. 

Клацання лівою кнопкою миші на потрібному вам кольорі в палітрі забарвить фігуру, а 

правою - забарвлення контур. Щоб прибрати заливку або контур, натисніть самий верхній 

перекреслений квадратик. 

 
Також ви можете зробити візерунки напівпрозорими, застосувавши інструмент 

Interactive Transparency tool. Точно також виділяємо візерунок і простягаємо зверху вниз або 

знизу вгору. Потім, пересуваючи чорний, білий квадратики або середній повзунок на лінії, 

утвореної інструментом, відрегулюйте прозорість. 
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От і все. Я знову змінила тінь, вірніше її напрямок, простягнувши її не знизу вгору, а 

зверху вниз і результат мені сподобався більше. 

 
Використовувати отримані нами векторні елементи можна по різному. 

Наприклад, ось ще один з варіантів. 

Створюємо напис, переводимо її в криві, точно також розміщуємо на ній векторні 

візерунки. 

 
Текст повинен бути внизу, а візерунок зверху. Тепер виділяємо все повністю і текст і 

візерунки. 

Натискаємо кнопку в панелі властивостей Back minus Front (або меню Arrange - Shaping 

- Back minus Front) 

І отримуємо ось такий симпатичний результат! 
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Практична робота 4. СТВОРЕННЯ ПРОЗОРОГО 3D КОНТЕЙНЕРА ЗА ДОПОМОГОЮ 

ФОНТАННОЇ ЗАЛИВКИ І ЗАЛИВКИ СІТКИ 

 

У цьому уроці ми продемонструємо процес створення прозорого 3D контейнера за 

допомогою фонтанної заливки і заливки сітки в CorelDRAW X7. Слідуючи цій покрокової 

інструкції, ви зможете створити об'єкт, показаний на малюнку нижче. 

 
Нам знадобляться такі команди і інструменти, як Прямокутник, Еліпс, Тінь, Заливка 

сітки, Відображення, Дублювання, Нахил, Масштаб і Поворот. 
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Запустіть CorelDRAW X7. Клацніть Створити на екрані вітання або виберіть Файл> 

Створити. Задайте зазначені параметри в діалоговому вікні Створення документа. Встановіть 

прапорець Прив'язка до об'єктів (Вид> Прив'язати до> Прив'язка до об'єктів). 

Створення площин куба 

Активуйте інструмент  Прямокутник (F6) в наборі інструментів і накресліть 

прямокутник. Змініть ширину прямокутника на 50 мм, а висоту - на 60 мм. (Див. Рис. 2 нижче.) 

Назвемо цей об'єкт Об'єкт-1. Відкрийте вікно настройки Перетворення і виберіть пункт 

Нахил (як варіант, можна вибрати Об'єкт> Перетворення> Нахил в рядку меню). Введіть 

значення -25 в полі Y: і клацніть Застосувати. Одержаний об'єкт повинен виглядати так, як 

показано на рис. 3. 

Тепер, утримуючи клавішу Ctrl, клацніть і протягніть середній лівий маркер вправо, щоб 

створити відбитий об'єкт, а потім клацніть один раз правою кнопкою миші, щоб дублювати 

об'єкт. Одержаний об'єкт назвемо Об'єкт-2 . (Див. Рис. 4.) 

 
Заповнення площин об'єкта кольором 

Об'єкт-1 

Виділіть Об'єкт-1 і залийте його червоним кольором (C0 M100 Y100 K0). Видаліть 

абрис (для цього правою кнопкою миші перечеркнуту клiтинку Немає кольору ). Натисніть 

F11, щоб відкрити діалогове вікно Фонтанна заливка. Клацніть кінцевий колірний вузол 

(позиція 100%) і змініть колір на більш насичений червоний (C0 M100 Y100 K80). Для цього 

клацніть маленький чорний трикутник (поруч зі зразком кольору вузла) і введіть параметри 

кольору. Натисніть кнопку ОК. 

Тепер виберіть інструмент Заливка сітки в наборі інструментів і виділіть рамкою 

центральний вузол. Клацніть зразок оранжевого кольору (C0 M60 Y100 K0) на колірній 

палітрі. За допомогою активованого інструменту Заливка сітки виділіть рамкою всі вузли і 

змініть рівень прозорості на 30% на панелі властивостей. (Див. Мал. 5 нижче.) 

Об'єкт-2 

Виділіть Об'єкт-2 і залийте його жовтим кольором (C0 M20 Y100 K0). Видаліть абрис 

(для цього правою кнопкою миші перечеркнуту клiтинку Немає кольору ). Натисніть F11, 

щоб відкрити діалогове вікно Фонтанна заливка. Клацніть кінцевий колірний вузол (позиція 

100%), змініть колір на більш насичений жовтий (C0 M20 Y60 K80) і клацніть OK. 

Тепер виберіть інструмент Заливка сітки в наборі інструментів і виділіть рамкою 

центральний вузол. Клацніть зразок жовтого кольору (C0 M0 Y100 K0) на колірній палітрі. За 

допомогою активованого інструменту Заливка сетки виделіте рамкою всі вузли і на панелі 

властивостей змініть рівень прозорості на 30%. (Див. Мал. 6 нижче.) 

Створення двох, що залишилися площин 

Протягнете Об'єкт-2 з нижнього лівого кута так, щоб прив'язати цей об'єкт до нижнього 

лівого кута Об'єкту-1. Не відпускаючи ліву кнопку миші, клацніть один раз правою кнопкою 

миші, щоб дублювати об'єкт. 

Натисніть Shift + PgDn, щоб перемістити об'єкт на задній план. У вікні настройки 

Перетворення виберіть пункт Повернути. В поле Кут повороту введіть значення 180 °. 

Натисніть кнопку Застосувати. Назвемо цей об'єкт Об'єкт-3. Одержаний об'єкт повинен 

виглядати так, як показано на рис. 7. Протягнете Об'єкт-1 з верхнього лівого кута так, щоб 
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прив'язати цей об'єкт до верхнього правого кута Об'єкту-3. Не відпускаючи ліву кнопку миші, 

клацніть один раз правою кнопкою миші, щоб дублювати об'єкт. 

Натисніть Shift + PgDn, щоб перемістити об'єкт на задній план. У вікні настройки 

Перетворення залиште все як є і натисніть кнопку Застосувати. Назвемо цей об'єкт Об'єкт-4. 

Одержаний об'єкт повинен виглядати так, як показано на рис. 8. 

 
 

Створення сфери 

Активуйте  інструмент Еліпс (F7) і намалюйте правильне коло, утримуючи клавішу 

Ctrl. Змініть висоту і ширину окружності на 50 мм. Для заливки форми на колірній палітрі 

виберіть пурпурний колір (C0 M100 Y0 K0). Видаліть абрис (для цього правою кнопкою миші 

перечеркнуту клiтинку Немає кольору ). 

Натисніть F11, щоб відкрити діалогове вікно Фонтанна заливка. Змініть тип переходу 

перетікання на еліптичний. Клацніть кінцевий колірний вузол (позиція 100%) і змініть колір 

на рожевий (C0 M40 Y20 K0). Сгладьте фонтану заливку, клацнувши значок Згладжування 

(справа внизу під полем Обтікання). В області Перетворення в поле X: введіть значення -22% 

в графі Горизонтальний зсув. В поле Y: введіть значення 30% в графі Вертикальний зсув. На 

ілюстрації нижче вказані потрібні параметри для фонтанної заливки. 

 

 
 

Одержаний об'єкт повинен виглядати так, як показано на рис. 9. 

Виберіть інструмент Тінь в наборі інструментів і, утримуючи клавішу Ctrl, злегка 

протягнете курсор від низу до верху від центральної частини сфери. В налаштуваннях 

інструменту Тінь на панелі властивостей встановіть значення в полях Непрозорість і 

Розмиття на 25 (див. Рис. 10). 
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Розмістіть сферу з тінню так, як показано на рис. 11 нижче. Виділіть Об'єкт-1 і Об'єкт-2 

і натисніть Shift + PgUp. Одержаний об'єкт повинен виглядати так, як показано на рис. 12. 
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Практична робота 5. РОБОТА З ІНСТРУМЕНТОМ «ПЕРЕТІКАННЯ» 

 

Інструмент «Перетікання» є одним з основоположних і самих практичних інструментів в 

CorelDRAW. Перетікання - це трансформація одного об'єкта в інший, яка представлена 

прогресією форм і кольорів. Результати роботи з цим інструментом дуже цікаві. 

1. Намалюємо пряму лінію і виберемо «Надтонкий абрис» (у вікні властивостей абрису 

(F12) або на панелі властивостей). 

 
2. Намалюємо другу лінію. Для цього існує кілька прийомів: можна дублювати першу 

лінію за допомогою правий упор кнопки миші під час переміщення лінії; можна натиснути «+» 

на цифровій клавіатурі під час переміщення лінії; також можна скористатися командою 

копіювання і вставки (Ctrl + C / Ctrl + V) або командою дублювання (Ctrl + D). Встановимо 

ширину лінії на 2.0 п. (У вікні властивостей абрису (F12) або на панелі властивостей). 

 
3. Активуйте інструмент «Інтерактивне перетікання» в випадаючому меню «Ефекти». 

Потім протягнете інструмент від однієї лінії до іншої (послідовність не має значення). В 

результаті повинен вийти градієнт ліній. 

 
4. Змініть колір кожної лінії (клацання лівою кнопкою миші по колірній палітрі). У нас 

вийшов градієнт, що складається з різнокольорових ліній різної ширини. 

 
5. На панелі властивостей змініть кількість кроків перетікання. Чим більше кроків, тим 

сильніше один об'єкт буде зливатися з іншим. 
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6. Використовуючи ефект перетікання при роботі з різними векторними об'єктами, 

включаючи текст, можна створювати цікаві переходи. Намалюємо зірку і багатокутник і 

заллємо їх різними кольорами 

.  

7. Перетягнемо інструмент перетікання від одного об'єкта до іншого. Щоб побачити 

ефект перетікання в дії, виберіть невелике (в залежності від розміру об'єкта) кількість 

кроків.  

7. Перетікання також дозволяє з легкістю імітувати ефект 3D. Наприклад, при 

перетікання тонкої і широкої ліній або двох прямокутників із закругленими кутами. 

 
8. Цікавих результатів можна також домогтися при роботі двома формами, такими як 

кола з широкими і вузькими контурами. 

 
9. По суті, перетікання прогресує від одного вузла до іншого. Якщо напрямок 

перетікання потрібно змінити, необхідно визначити потрібні вузли на панелі властивостей, 

вибрати опцію «Вибрати вузли» і за допомогою чорної стрілки виділити два вузла (по одному в 

кожній формі). 
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10. Завдяки підвищеному контролю опція «Вибрати вузли» дозволяє створювати більш 

плавний і якісний ефект перетікання. 

 
11. Давайте поекспериментуємо. Намалюємо квадрат (для цього потрібно протягнути 

інструмент прямокутника, утримуючи клавішу Ctrl) і змінимо колір абрису на синій. Дублюємо 

об'єкт (клацніть «+» на цифровій клавіатурі або скористайтеся командою копіювання і вставки) 

і змінимо колір нового квадрата на блакитний. 

Виділимо обидва квадрата і виберемо пункт «Перетікання» в меню «Ефекти». 

Відкриється вікно налаштування «Перетікання». Не змінюючи нічого в настройках за 

умовчанням, клацнемо кнопку «Застосувати». 
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На перший погляд нічого не сталося. Це дійсно так, адже об'єкти вирівняні і мають 

однаковий розмір. А тепер виділіть тільки один квадрат і поверніть його на 180º (на панелі 

властивостей). Хоча поворот на 180º не змінив форму квадрата, він змінив напрямок 

перетікання за рахунок переміщення вузлів. 

 
1. Знову виділіть той же квадрат і виберіть опцію "Відбити по горизонталі». 

 
Тепер, виділивши той же квадрат, задайте поворот 270 °. 
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Потім, виділивши всі той же квадрат, знову виберіть опцію "Відбити по горизонталі». 

 
Виберіть групу перетікання. У вікні настройки «Перетікання» змініть напрямок 

перетікання на 180º, активуйте опцію «Петля» і натисніть кнопку «Застосувати». 
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Знову виділіть той же квадрат і змініть напрямок перетікання на 180º. У нас вийшов 

круг! 

 
2. Знову виберіть групу перетікання і у вікні настройки «Перетікання» встановіть 

кількість кроків на позначку 100 (20 за замовчуванням), а для направлення перетікання виберіть 

360. Натисніть кнопку «Применить». 
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Установка різних значень призводить до різних результатів. І це все - за допомогою 

всього двох квадратів! 

 
3. Раніше ми користувалися однаковими квадратами. А якщо розміри квадратів будуть 

відрізнятися? Змінимо кількість кроків на 50, встановимо значення напряму перетікання по 

петлі на 360º і натиснемо «Застосувати». Потім виділимо і зменшимо або збільшимо один з 

квадратів. 
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4. Хочете побачити приклад роботи з іншою формою? Давайте виберемо «Еліпс» (F7) і 

за допомогою інструменту «Форма» (F10) створимо арку. Дублюємо об'єкт (клацніть «+» на 

цифровій клавіатурі або скористайтеся командою копіювання і вставки) і змінимо колір 

кожного об'єкта. 

 
Виберемо значення 50 для кількості кроків, а 360 - для направлення перетікання по петлі. 

У нас вийшов ось такий бублик! 
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Зміна напрямку перетікання на 180º дасть абсолютно інший результат. 

 
За допомогою повороту, відображення або переміщення одного з об'єктів ви зможете 

створювати різноманітні нові форми і ефекти. 
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Практична робота 6. РОБОТА З КОНТУРАМИ В CORELDRAW 

 

Команда Контур додає обмежує форму (або форми) до виділеного векторному або 

текстовому об'єкту. У цьому уроці ми розглянемо настройки, за допомогою яких можна 

створювати різні типи контурів, також поговоримо про способи застосування цих контурів. 

Інструмент Контур знаходиться в випадаючому меню Ефекти на панелі інструментів 

(для відображення меню, що випадає наведіть чорну стрілку на кнопку Ефекти). Поєднання 

клавіш Ctrl + F9 відкриває вікно настройки Контур. Це вікно також можна відкрити, вибравши 

Ефекти> Контур в рядку меню. 

 

Налаштування панелі властивостей «Контур» 

 
Типи контурів: 

1. До центру: контури створюються зі зміщенням до центру. Для цього типу контурів дії 

прораховуються автоматично з урахуванням відстані зсуву і вільного простору всередині 

об'єкта. В даному випадку користувач не може вплинути на настройки. 

2. Внутрішній контур: для створення внутрішнього контуру об'єкта значення відстані зсуву і 

кількості кроків можуть бути задані користувачем. (В разі, коли задану відстань зміщення 

більше вільного місця, доступного для створення вищевказаних типів контуру, з'являється 

повідомлення «Зсув контуру занадто велике».) 

3. Контур абрису: для створення контуру абрису відстань зміщення і кількість кроків також 

можуть бути задані користувачем. 

Застосування контуру 

Контури можна застосовувати до векторних об'єктів і фігурного тексту. 

Контури можуть бути додані двома способами: 

1. Клацніть виділений об'єкт і за допомогою інструменту Контур протягнете назовні або 

всередину. 

2. Виберіть об'єкт і клацніть будь-яку кнопку типу контурів на панелі властивостей. 

Після того як контур доданий до об'єкта, для досягнення бажаного результату можна змінювати 

налаштування на панелі властивостей. 

 

Приклади простих контурів 

Додавання контуру до текстового об'єкту 
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Застосований контур (Тип контуру: внутрішній контур, Кроки контуру: 9 кроків, Зсув 

контуру: 0.5 мм, Кут: скошений, Колір заливки: червоний, Колір абрису: без абрису). 

 
Додавання контуру до векторного об'єкту (див. Зображення нижче) 

1. Тип контуру: контур абрису, Кроки контуру: 9 кроків, Зсув контуру: 0.5 мм, Кут: 

скошений, Колір заливки: червоний, Колір абрису: червоний. 

2. Тип контуру: до центру, Кроки контуру: НД, Зсув контуру: 0.5 мм, Кут: скошений, Колір 

заливки: червоний, Колір абрису: червоний. 

3. Тип контуру: внутрішній контур, Кроки контуру: 2 кроки, Зсув контуру: 1 мм, Кут: 

скошений, Колір заливки: червоний, Колір абрису: червоний. 

 
Контури можуть бути розділені за допомогою команди Роз'єднати (Ctrl + K). Об'єкт буде 

відділений від контурів, число яких дорівнює заданому числу кроків. Після роз'єднання об'єкти 

контурів будуть згруповані. 

Використання контурів для створення цікавих ефектів 

Крок 1: фігурний текст із застосованим контуром (Тип контуру: внутрішній контур, Кроки 

контуру: 1 крок, Зсув контуру: 1 мм, Кут: скошений, Колір заливки: білий, Колір абрису: 

без абрису). 

 
Крок 2: роз'єднати контур, натиснувши Ctrl + K. Контур і об'єкт тексту будуть розділені. 

(Колір контуру був змінений з білого на синій для підвищення видимості.) 

 
Крок 3: тепер, зберігаючи розташування вихідного тексту і об'єкта контуру без змін, створіть 

дублікат (Ctrl + D) і змістите вихідний текст по горизонталі. Об'єкт блакитного кольору внизу є 

зсунутим по горизонталі дублікатом вихідного текстового об'єкта червоного кольору. 

 
Крок 4: використовуйте об'єкт блакитного кольору (дублікат) для обрізки об'єкта білого 

кольору. Результат повинен виглядати так, як показано на ілюстрації внизу. Для виконання 

обрізки виділіть обидва об'єкти і клацніть значок обрізки на панелі властивостей. Після 

закінчення дублікат можна видалити. 

 
Використання контурів для створення затінення в складних ілюстраціях 

Для створення потрібної форми і вибору правильного кольору для створення ідеального 

затінення необхідні певні навички. 



71 

 

На кольоровий ілюстрації внизу зображені контури, застосовані до різноманітних форм для 

створення ефекту затінення. Ілюстрація, в якій використовується інший ефект (наприклад, 

Перетікання) може містити кілька об'єктів. 

1. Вихідний векторний об'єкт / форма 

2. Об'єкт контуру, залитий Фонтанній заливкою від C0 M25 Y25 K0 до C0 M50 Y45 K0, без 

абрис 
3. Параметри застосованого контуру: Тип контуру: до центру, Зсув контуру: 0.3 мм, Кут: 

скошений, Колір заливки: від C0 M35 Y40 K0 до C0 M20 Y25 K0 

4. Каркасний вид об'єкта (Вид> Каркас) після застосування контуру 

 
Кольорова ілюстрація містить області кольорового затінення, за допомогою яких був 

імітований ефект 3D. У більшості випадків на цій ілюстрації кольорове затінення було створено 

за допомогою використання різноманітних форм і контурів з різними настройками. Порівняйте 

кольорову ілюстрацію з каркасним видом, щоб краще уявити собі області, до яких міг бути 

застосований контур. 

 

Інші настройки контурів, які можна використовувати для створення різних ефектів 

Колірний перехід: для створення переходу між кольором вихідного об'єкта і кольором контуру 

представлені три опції. Колір заливки і колір абрису будуть змішуватися в залежності від 

обраного варіанту. Опції колірного переходу: а) Колір контуру лінії; б) Колір контуру за 

годинниковою стрілкою; в) Колір контуру проти годинникової стрілки. 

Прискорення: використовуючи параметр прискорення, можна задавати частоту, з якою контур 

буде змінювати форму між кроками. У вікні настройки Контур значення прискорення також 

може бути задано і для кольору. 

Кут: кути контуру можуть бути гострими, закругленими або скошеними. 

На додаток до імітації тривимірних ефектів інструмент «Контур» дозволяє створювати 

вирізаються контури для виведення на плоттери, гравірувальні машини і пристрої для різання 

вінілу. Крім того, контури можуть бути використані для додавання розтікання до художнім 

об'єктам, що призначаються для офсетного і трафаретного друку. 
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